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reasonable efforts based on information available as of the date of issue of this document.

The scope of information in this document may exceed that which Arm is required to provide,
and such additional information is merely intended to further assist the recipient and does not
represent Arm’s view of the scope of its obligations. You acknowledge and agree that you possess
the necessary expertise in system security and functional safety and that you shall be solely
responsible for compliance with all legal, regulatory, safety and security related requirements
concerning your products, notwithstanding any information or support that may be provided by
Arm herein. conjunction with any Arm technology described in this document, and to minimize
risks, adequate design and operating safeguards should be provided for by you.

This document may include technical inaccuracies or typographical errors. THIS DOCUMENT IS
PROVIDED "AS IS". ARM PROVIDES NO REPRESENTATIONS AND NO WARRANTIES, EXPRESS,
IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES
OF MERCHANTABILITY, SATISFACTORY QUALITY, NON-INFRINGEMENT OR FITNESS FOR A
PARTICULAR PURPOSE WITH RESPECT TO THE DOCUMENT. For the avoidance of doubt, Arm
makes no representation with respect to, and has undertaken no analysis to identify or understand
the scope and content of, any patents, copyrights, trade secrets, trademarks, or other rights.

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT WILL ARM BE LIABLE FOR

ANY DAMAGES, INCLUDING WITHOUT LIMITATION ANY DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND
REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF ANY USE OF THIS
DOCUMENT, EVEN IF ARM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Reference by Arm to any third party’s products or services within this document is not an express
or implied approval or endorsement of the use thereof.

This document consists solely of commercial items. You shall be responsible for ensuring that
any permitted use, duplication, or disclosure of this document complies fully with any relevant
export laws and regulations to assure that this document or any portion thereof is not exported,
directly or indirectly, in violation of such export laws. Use of the word “partner” in reference to
Arm’s customers is not intended to create or refer to any partnership relationship with any other
company. Arm may make changes to this document at any time and without notice.

This document may be translated into other languages for convenience, and you agree that if there
is any conflict between the English version of this document and any translation, the terms of the
English version of this document shall prevail.

The validity, construction and performance of this notice shall be governed by English Law.

The Arm corporate logo and words marked with ® or ™ are registered trademarks or trademarks

of Arm Limited (or its affiliates) in the US and/or elsewhere. Please follow Arm’s trademark usage
guidelines at https:/www.arm.com/company/policies/trademarks. All rights reserved. Other brands
and names mentioned in this document may be the trademarks of their respective owners.

Arm Limited. Company 02557590 registered in England.

110 Fulbourn Road, Cambridge, England CB1 9NU.
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Confidentiality Status

This document is Non-Confidential. The right to use, copy and disclose this document may be
subject to license restrictions in accordance with the terms of the agreement entered into by Arm
and the party that Arm delivered this document to.

Unrestricted Access is an Arm internal classification.

Product Status

The information in this document is Final, that is for a developed product.

Feedback

Arm welcomes feedback on this product and its documentation. To provide feedback on the
product, create a ticket on https:/support.developer.arm.com

To provide feedback on the document, fill the following survey: https:/developer.arm.com/
documentation-feedback-survey.

Inclusive language commitment

Arm values inclusive communities. Arm recognizes that we and our industry have used language
that can be offensive. Arm strives to lead the industry and create change.

We believe that this document contains no offensive language. To report offensive language in this
document, email terms@arm.com.
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Introduction

1. Introduction

1.1 Conventions
The following subsections describe conventions used in Arm documents.

Glossary

The Arm Glossary is a list of terms used in Arm documentation, together with definitions for
those terms. The Arm Glossary does not contain terms that are industry standard unless the Arm
meaning differs from the generally accepted meaning.

See the Arm Glossary for more information: developer.arm.com/glossary.

Typographic conventions
Arm documentation uses typographical conventions to convey specific meaning.

Convention Use
italic Citations.
bold Interface elements, such as menu names.
Terms in descriptive lists, where appropriate.
monospace Text that you can enter at the keyboard, such as commands, file and program names, and source code.
monospace underline A permitted abbreviation for a command or option. You can enter the underlined text instead of the full
command or option name.
<and> Encloses replaceable terms for assembler syntax where they appear in code or code fragments.
For example:
MRC pl5, 0, <Rd>, <CRn>, <CRm>, <Opcode 2>
SMALL CAPITALS Terms that have specific technical meanings as defined in the Arm® Glossary. For example,
IMPLEMENTATION DEFINED, IMPLEMENTATION SPECIFIC, UNKNOWN, and UNPREDICTABLE.

We recommend the following. If you do not follow these recommendations your
system might not work.

A Your system requires the following. If you do not follow these requirements your

system will not work.
Warning

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
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You are at risk of causing permanent damage to your system or your equipment, or
of harming yourself.

o
* This is important information and needs your attention.

Note

A useful tip that might make it easier, better or faster to perform a task.

¥ A reminder of something important that relates to the information you are reading.

Remember

1.2 Other information

See the Arm website for other relevant information.

e Arm® Developer.
e Arm® Documentation.
e Technical Support.

e Arm® Glossary.
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Extension pack and extensions

2. Extension pack and extensions

The Arm® Keil® Studio Visual Studio Code extension pack, Arm Keil Studio Pack, provides a
comprehensive software development environment for embedded systems and lol software
development on Arm-based microcontroller (MCU) devices. Use the Keil Studio extensions
contained in the pack to manage your CMSIS solutions (csolution projects), and to create, build,
test, and debug embedded applications on your chosen hardware.

The Keil Studio extensions are part of the Arm Keil Microcontroller Development Kit (MDK). MDK
is a collection of software tools for developing embedded applications based on Arm Cortex®-M
and Ethos™-U processors. MDK gives you the flexibility to work with a command-line interface
(CLI) or an integrated development environment (IDE), or by deploying the tools into a continuous
integration workflow.

2.1 Arm Keil Studio Pack

The Arm® Keil® Studio Pack is collection of Visual Studio Code extensions. The pack provides the
software development environment for embedded systems and loT software development on Arm-
based microcontroller (MCU) devices.

The Keil Studio Pack contains the following extensions:

e Arm CMSIS csolution (Identifier: arm. cmsis-csolution): This extension provides support for
working with CMSIS solutions (csolution projects).

e Arm Debugger (Identifier: arm.arm-debugger): This extension provides access to the Arm
Debugger engine for Visual Studio Code by implementing the Microsoft Debug Adapter
Protocol (DAP). Arm Debugger supports connections to physical targets, either through
external debug probes such as the Arm’s ULINK™ family of debug probes, or through on-board
low-cost debugging such as ST-Link or CMSIS-DAP based debug probes.

e Arm Device Manager (Identifier: arm.device-manager): This extension allows you to manage
hardware connections for Arm Cortex®-M based microcontrollers, development boards, and
debug probes.

e Arm Environment Manager (Identifier: arm.environment-manager): This extension installs the
tools that you specify in a manifest file in your environment. For example, you can install Arm
Compiler for Embedded, CMSIS-Toolbox, CMake, and Ninja to work with CMSIS solutions.

e Arm Virtual Hardware (Identifier: arm.virtual-hardware): This extension allows you to manage
Arm Virtual Hardware and run embedded applications on virtual targets. An authentication
token is required to access the service. For more details on AVH, read the overview.

e Memory Inspector (Identifier: eclipse-cdt.memory-inspector): This extension allows you to
analyze and monitor the memory contents in an embedded system. It helps you to identify and
debug memory-related issues during the development phase of your project.

e Peripheral Inspector (Identifier: eclipse-cdt.peripheral-inspector): This extension
uses System View Description (SVD) files to display peripheral details. SVD files provide
a standardized way to describe the memory-mapped registers and peripherals of a
microcontroller or a System-on-Chip (SoC).

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
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Extension pack and extensions

e The Arm Virtual Hardware extension is in development, and is not described in
this guide.

e The Memory Inspector and the Peripheral Inspector are third-party open-source
extensions and are not described in this guide.

You can also install and use the extensions contained in the pack individually. However, Arm
recommends installing the Keil Studio Pack in Visual Studio Code Desktop to quickly set up your
environment and start working with an example. See the pack README file for more details.
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Intended use cases for the extensions

3. Intended use cases for the extensions

The intended use cases for the extensions are as follows:

Embedded and loT software development using CMSIS-Packs and csolution projects: The
Common Microcontroller Software Interface Standard (CMSIS) provides driver, peripheral,

and middleware support for thousands of MCUs and hundreds of development boards. Using
the csolution project format, you can incorporate any CMSIS-Pack based device, board, and
software component into your application. For more information about supported hardware for
CMSIS projects, go to the Boards and Devices pages on keil.arm.com. For information about
CMSIS-Packs, go to open-cmsis-pack.org.

Enhancement of a pre-existing Visual Studio Code embedded software development
workflow: You can adapt USB device management and embedded debugging to other project
formats (for example CMake) and toolchains without additional overhead. This use case
requires familiarity with Visual Studio Code to configure tasks. See the individual extensions for
more details.
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Get started with an example project

4. Get started with an example project

Set up your environment and start working with an example.

This section describes working with example csolution or Vision projects that
you can download from keil.arm.com. You can also create csolution projects from
scratch, or convert your existing pVision projects to csolution format. For more
information, see Create a csolution project and Convert a Keil pVision project to a
csolution project.

We recommend installing the Keil Studio Pack in Visual Studio Code Desktop as explained in

the README file. The pack installs all the Keil® Studio extensions, as well as the Red Hat YAML,

Microsoft C/C++, and Microsoft C/C++ Themes extensions.

Then:

e Run the setup process using an example csolution project from keil.arm.com (recommended).

e Download a Keil 1Vision *.uvproix project from keil.arm.com and convert it to a csolution
(alternative).

The examples available on keil.arm.com are shipped with a Microsoft vcpkg manifest file (vepkg-
configuration.json). The Environment Manager extension uses the manifest file to acquire and
activate the tools that you need to work with csolution projects using Microsoft vcpkg.

Each example also comes with a tasks.json file and a 1aunch.json file to build, run, and debug the
project.

The tools installed by default are:

e Arm® Compiler for Embedded.

o CMSIS-Toolbox.

e (CMake and Ninja.

Finalize the setup of your development environment. If you do not want to use Microsoft C/C++
and Microsoft C/C++ Themes, you can install and set up the clangd extension instead to add smart
features to your editor.
When you are ready:
e Build the example project.
e Explore what you can do with the CMSIS csolution extension:

o Set a context

o Look at the Solution outline

o Install CMSIS-Packs and select software components from packs
e Connect your board and run the example on the board.
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Start a debug session.

Check the serial output.

4.1 Import a csolution example

Import a csolution example in Visual Studio Code, or download a zip file that contains the csolution.

Procedure

1.

2.
3.
4

10.

11.
12.

13

Go to keil.arm.com.
Click the Hardware menu and select Boards.
Search for your board and select it in the Suggested Boards list.

Find a project in the Projects tab.
The keil studio compatibility label indicates that the example is compatible with Keil® Studio
Cloud and the Keil Studio Visual Studio Code extensions.

Move your cursor over Get Project, and then click Open in Keil Studio for VS Code to import
the csolution example.

Alternatively, you can download a zip file that contains the csolution with the Download .zip
option.

In the “Open Visual Studio Code?” dialog box that opens at the top of your browser window,
click Open Visual Studio Code.

In the “Allow ‘Arm Keil Studio Pack’ extension to open this URI?” dialog box that opens in Visual
Studio Code, click Open.

Choose a folder to import the project and click Select as Unzip Destination.

In the “Would you like to open the unzipped folder, or add it to the current workspace?” dialog
box, click Open.

Confirm that the Environment Manager extension can automatically activate the workspace and
download the tools specified in your vepkg-configuration.json file.

If there are missing CMSIS-Packs, a pop-up message displays in the bottom right-hand corner
with the following message: “Solution [solution-name] requires some packs that are not
installed”.

Click Show Missing Packs to open the PROBLEMS view.

Right-click the error in the PROBLEMS view and select Install missing pack. If there are several
packs missing, use Install all missing packs.

You must activate a license to be able to use tools such as Arm® Compiler, Arm Debugger, or
Fixed Virtual Platforms in your toolchain. If you have not activated your license after installing
the pack, a pop-up message displays in the bottom right-hand corner. See Activate your license
to use Arm tools for more details on licensing.

" Click Explorer @

A vepkg-configuration.json iS available. The file records the vcpkg artifacts, such as the
compiler toolchain version, that you need to work with your projects. You do not need to do
anything to install the tools. Microsoft vcpkg and the Environment Manager extension take care
of the setup. See Tools installation with Microsoft vcpkg.
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A tasks.json file and a 1aunch.json file are also available in the .vscode folder. Visual Studio
Code uses the tasks.json file to build and run the project, and the 1aunch.json file for
debugging.

4.2 Download and convert a Keil uVision example

Download a Keil® Vision® * . uvprojx project from keil.arm.com and convert it to a csolution. Note
that conversion does not work with Arm® Compiler 5 projects. You can download Arm Compiler

5 projects from the website, but you cannot use them with the extensions. Only Arm Compiler

6 projects can be converted. As a workaround, you can update Arm Compiler 5 projects to Arm
Compiler 6 in Keil uVision, then convert the projects to csolutions in Visual Studio Code. For more
help and information on converting to Arm Compiler 6, see the Migrate Arm Compiler 5 to Arm
Compiler 6 application note and the Arm Compiler for Embedded Migration and Compatibility
Guide.

Procedure
1. Go to keil.arm.com.

2. Connect your board over USB and click Detect Connected Hardware in the bottom right-hand
corner.

3. Select the device firmware for your board in the dialog box that displays at the top of the
window, and then click Connect.

4. Click the Board link in the pop-up message that displays in the bottom right-hand corner.
The page for the board opens. Example projects are available in the Projects tab.

5. Look for an example with a uvision compatibility label.

6. Move your cursor over the Get Project button for the project that you want to use and click
Download .zip to download the Keil uVision *.uvprojx example.

7. Unzip the example and open the folder in Visual Studio Code.
8. Right-click the *.uvprojx and select Convert pVision Project to Csolution from the Explorer.

&

Alternatively, if you are starting from an empty workspace, you can click CMSIS E&E in the
Activity Bar to open the CMSIS view. Then choose one of the following two options:

e Click Convert a pVision Project and open your *.uvprojx file to convert it

Move your cursor over the Solution outline, click More Actions ! then select Convert
KVision Project to Csolution and open your *.uvprojx file to convert it

The conversion starts immediately.

A dialog box displays. You can carry out the following tasks:
e Open the solution in a new workspace (Open option)

e Open the solution in a new window and new workspace (Open project in new window
option)
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You can also run the CMSIS: Convert pVision project to Csolution command from the
Command Palette. In that case, select the *.uvprojx that you want to convert on your machine
and click Select.

If there are conversion errors, check the uv2csolution. log file available.

Confirm that the Environment Manager extension can automatically activate the workspace and
download the tools specified in your vepkg-configuration.json file.

10. Check the OUTPUT tab (View > Output). Select uVision to Csolution Conversion in the drop-

11.
12.

down list on the right-hand side of the OUTPUT tab.

If there are missing CMSIS-Packs, a pop-up message displays in the bottom right-hand corner
with the following message: “Solution [solution-name] requires some packs that are not
installed”.

Click Show Missing Packs to open the PROBLEMS view.

Right-click the error in the PROBLEMS view and select Install missing pack. If there are several
packs missing, use Install all missing packs.

You must activate a license to be able to use tools such as Arm® Compiler, Arm Debugger, or
Fixed Virtual Platforms in your toolchain. If you have not activated your license after installing
the pack, a pop-up message displays in the bottom right-hand corner. See Activate your license
to use Arm tools for more details on licensing.

The *.cproject.yml and *.csolution.yml files are available next to the *.uvprojx in the

Explorer @

A vepkg-configuration.json file is available. The file records the vepkg artifacts, such as the
compiler toolchain version, that you need to work with your projects. You do not need to do
anything to install the tools. Microsoft vcpkg and the Environment Manager extension take care
of the setup. See Tools installation with Microsoft vcpkg.

A tasks.json file and a 1aunch.json file are also available in the .vscode folder. Visual Studio
Code uses the tasks.json file to build and run the project, and the 1aunch.json file for
debugging.

4.3 Finalize the setup of your development environment

To finalize the setup of your development environment:

Configure an HTTP proxy. This step is required only if you are working behind an HTTP proxy.

The pack installs all the Keil® Studio extensions, as well as the Red Hat YAML, Microsoft C/C
++, and Microsoft C/C++ Themes extensions. If you do not want to use the Microsoft C/C+
+ and Microsoft C/C++ Themes extensions, you can disable them in Visual Studio Code and
install and set up the clangd extension instead.
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4.3.1 Configure an HTTP proxy (optional)

This step is required only if you are working behind an HTTP proxy. You can configure the tools to
use an HTTP proxy using the following standard environment variables:

e uTTP PrOXY: Set to the proxy used for HTTP requests

e HTTPS PROXY: Set to the proxy used for HTTPS requests

e No_PrOxY: Set to include at least 1ocalhost,127.0.0.1 to disable the proxy for internal traffic,
which is required for the extension to work correctly

4.3.2 clangd (alternative)

Install the clangd extension. Similarly to the Microsoft C/C++ and Microsoft C/C++ Themes
extensions, clangd adds smart features such as code completion, compile errors, and go-to-
definition to your editor.

The clangd extension requires the clangd language server. If the server is not found
on your PATH, add it with the clangd: Download language server command from
the Command Palette. Read the clangd extension reapmr file for more information.

After clangd has been installed, no extra setup is needed. The CMSIS csolution extension generates
a compile commands.json file for each project in a solution whenever a csolution file changes or
when you change the context of a solution (Target and Build types). A .clangd file is kept up to
date for each project in the solution. The .c1angd file is used by the clangd extension to locate the
compile commands.json files and to enable IntelliSense. See the clangd documentation for more
details.

To turn off the automatic generation of the .clangd file and compile commands.json file:
1. Open the settings:

e On Windows or Linux, go to File > Preferences > Settings.

e On macQOs, go to Code > Settings > Settings.

2. Find the Cmsis-csolution: Auto Generate Clangd File and Cmsis-csolution: Auto Generate
Compile Commands settings. Clear their checkboxes.

4.4 Build the example project

Check that your example project builds. You can build your project from the Explorer using Build,
from the Solution outline, or from the Command Palette.

Procedure
1. Build the project:
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e From the Explorer:

a Go to the Explorer view @

b. Right-click the *.csolution.yml file and select Build.

These options are also available in the right-click menu:
o Clean: cleans the output directories for the active solution
o Rebuild: cleans the output directories before building the cproject

e From the Solution outline:

3
g in the Activity Bar.

Click CMSIS

The Solution outline opens.

b. Move your cursor over the Solution outline.
Build icons are available at the solution or project level.

¢ Click Build B

The Clean and Rebuild options are also available with More Actions !
You can configure a build task in a tasks.json file to customise the behaviour of

the build button. A tasks.json file is provided for all the examples available on
keil.arm.com. See Configure a build task for more details.

e From the Command Palette: Build, Clean, and Rebuild can also be triggered from the
Command Palette with the CMSIS: Build, CMSIS: Clean, and CMSIS: Rebuild commands.

2. Check the TERMINAL tab to find where the ELF file (.axf) was generated.

4.5 Choose a context for your csolution

A context is the combination of a target type (build target) and build type (build configuration) for a
particular project in your solution.

You can choose between pebug Or Release for the build type.

Read Set a context for your csolution for more details.

4.6 Look at the Solution outline

The Solution outline presents the content of your solution in a tree view.

Read Use the Solution outline for more details.
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4.7 Install CMSIS-Packs and select software components
from packs

CMSIS-Packs contain reusable software components that you can use to quickly build projects.
CMSIS-Packs are listed in the csolution.yml files of solutions. The CMSIS csolution extension
seamlessly handles the installation of packs to your pack cache.

See CMSIS-Packs and Install CMSIS-Packs for more details.

The Software Components view shows all the software components selected in the active project
of your solution.

Read Manage software components for more details.

4.8 Connect your board

Connect your board. See Supported hardware for more details on the development boards, MCUs,
and debug probes supported by the extensions.

Procedure
1.

Click Device Manager && in the Activity Bar to open the Device Manager extension.

2. Connect your board to your computer over USB.

The board is detected and a pop-up message displays.
3. Click OK in the pop-up message to use the hardware.

Your board is now ready to be used to run and debug a project.

4.9 Run the csolution on your board
Run the csolution project on your board.

Procedure

1. &
Click CMSIS E& in the Activity Bar.

The Solution outline opens.

2. Move your cursor over the Solution outline.
Run icons are available at the solution level.

3 Click Run B

You can configure a run task in a tasks.json file to customise the behaviour of the run button.
A tasks.json file is provided for all the examples available on keil.arm.com. See Run your
project on your hardware with Arm Debugger for more details.

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 20 of 70



Arm® Keil” Studio Visual Studio Code Extensions User Guide Document ID: 108029_0000_10_en

Get started with an example project

4. If you are using a device with multiple cores and you did not specify a "processorName" in the
launch.json file, and you do not have the CMSIS csolution extension installed, then you must
select the appropriate processor for your project in the Select a processor drop-down list that
displays at the top of the window.

The project is run on the board.

5. Check the TERMINAL tab.

4.10 Start a debug session
Start a debug session.

Procedure
1.

. A .
Click CMSIS E=| in the Activity Bar.

The Solution outline opens.

2. Move your cursor over the Solution outline.
Debug icons are available at the solution level.

Click Debug E

You can configure a launch configuration in a 1aunch. json file to customise the behaviour of
the debug button. A 1aunch.json file is provided for all the examples available on keil.arm.com.
See Debug your project with Arm Debugger for more details.

4. If you are using a device with multiple cores and you did not specify a "processorName" in the
launch.json file, and you do not have the CMSIS csolution extension installed, then you must
select the appropriate processor for your project in the Select a processor drop-down list that
displays at the top of the window.

The RUN AND DEBUG view displays and the debug session starts. The debugger stops at the
“main” function of your project.

5. Check the DEBUG CONSOLE tab to see the debugging output.

Next steps
Look at the Visual Studio Code documentation to learn more about the debugging features
available in Visual Studio Code.
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5. Arm Environment Manager extension

The Arm® Environment Manager extension allows you to manage environment artifacts, such as a
compiler toolchain, using Microsoft vcpkg. The extension uses a vcpkg manifest file to acquire and
activate the artifacts that you need to set up your development environment.

The artifacts for your project are stored in the vepkg-configuration.json file in the project source
code. This means that the same tools are available to everyone using the project.

If you do not want to use vcpkg, you can install the artifacts for your project by downloading and
installing the CMSIS-Toolbox. For more information see the CMSIS-Toolbox installation instructions
in the Open-CMSIS-Pack documentation.

The Environment Manager extension also includes features to help you license your tools. See
Activate your license to use Arm tools for more details.

5.1 Tools installation with Microsoft vcpkg

Arm uses Microsoft vcpkg to set up your environment. Microsoft vcpkg works in combination with
the Environment Manager extension installed with the pack for the setup.

Each official Arm example project is shipped with a manifest file (vepkg-configuration.json). The
manifest file records the vcpkg artifacts that you need to work with your projects. An artifact is a

set of packages required for a working development environment. Examples of relevant packages
include compilers, linkers, debuggers, build systems, and platform SDKs.

For more information on vcpkg, see the official Microsoft vcpkg documentation. See also the
Microsoft vcpkg-tool repository for more details on artifacts.

5.2 Check the tools installed with Microsoft vcpkg

The vepkg-configuration.json manifest file instructs Microsoft vepkg to install the artifacts. For
example:

"requires": {
"arm:tools/open-cmsis-pack/cmsis-toolbox": "~2.0.0-0",
"arm:compilers/arm/armclang": "*6.20.0",
"microsoft:tools/kitware/cmake"™: "~3.25.2",
"microsoft:tools/ninja-build/ninja": "~1.10.2"

The artifacts installed with this example manifest file are cmsis-toolbox, armclang (Arm Compiler for
Embedded), cmake, and ninja.

Go to the OUTPUT tab (View > Output) and select the vepkg category in the drop-down list to
see what has been installed. By default, Microsoft vcpkg installs the tools in the Visual Studio Code
application directory.
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After Microsoft vcpkg has been activated for a project, any terminal that you open in Visual Studio
Code has all the tools added to the PATH by default (Arm Compiler for Embedded, CMSIS-Toolbox,
CMake, and Ninja). This process allows you to run the different CMSIS-Toolbox tools such as
cpackget, cbuildgen, cbuild, OI csolution.

5.3 Modify the manifest file

To add or change tools in your environment, modify the artifacts contained in the manifest file of
your project.

The artifacts provided by Arm are listed on the Arm tools available in vcpkg page on keil.arm.com.

Copy the code snippets for the artifacts that you want to install and paste them in the vepkg-
configuration.json manifest file of your project in the "requires™: section, then save the file.
The newly added or updated artifacts are automatically downloaded and activated.

5.4 vcpkg activation options

Several options are available to activate, deactivate, or reactivate your environment with Microsoft
vcpkg and update your vepkg registries. If you are using an example from keil.arm.com or if

you created a csolution project from scratch from the Create New CMSIS Solution view, your
environment is activated by default.

Procedure
1. From the Explorer, open your workspace.

2. Right—click the vcpkg-configuration.json file.
Depending on the activation status of your environment and the Environment Manager
settings selected, the following options are available:

¢ Activate environment: Activate the environment. This option is available only if you
previously deactivated your environment or if you modified the Activate On Config
Creation or Activate On Workspace Open settings for the Environment Manager. Tools
are available on the PATH.

¢ Deactivate environment: Deactivate the active environment. Tools are also removed from
the PATH.

e Reactivate environment: Deactivate and activate the environment (for example, if you have
changed your vcpkg configuration).

o Update Tool Registry: Check for fresh artifacts published in the registries.

The same options are available when you click Arm Tools in the status bar. With the View
Log option, you can also open the OUTPUT tab to check what tools have been installed. The
Configure Arm Tools Environment option opens the visual editor. See Use the Environment
Configuration visual editor.
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5.5 Use vcpkg from the command line

You can also use vcpkg from the command line to create reproducible tool installations.
Information about vcpkg is available at vcpkg.io and at Microsoft Learn.

The Arm Developer Learning Paths also have an example scenario that shows you how to install
and initialize vcpkg, and how to create and use the configuration file. See Install tools on the
command line using vcpkg.

5.6 Confirm automatic activation

If you open a new workspace, duplicate an existing workspace, or open an example project from
keil.arm.com, the Environment Manager extension automatically activates the workspace and
downloads the tools specified in your vepkg-configuration.json file. A dialog box opens, allowing
you to confirm the activation. You can open the vepkg-configuration.json file to see what will be
installed.

You can also change the automatic activation settings at any time from File > Preferences >
Settings > Workspace > Extensions > Environment Manager.

5.7 Use the Environment Configuration visual editor

As an alternative to editing the vepkg-configuration.json manifest file directly, you can use the
Environment Configuration visual editor to add or change tools in your environment.

Procedure

1. Right-click anywhere in the Explorer view.

2. From the menu that opens, select Show Environment Configuration.
The Environment Configuration editor opens.

You can also open the editor by clicking Arm Tools in the status bar and selecting the
Configure Arm Tools Environment option in the drop-down list that displays at the top of the
window.

3. Use the drop-down lists to install or update the tools that you want to use in your environment.
If Auto Save is not enabled (File > Auto Save), save your settings.

The newly added or updated tools are automatically downloaded and activated. You can view
details of what has been installed in the OUTPUT tab (View > Output).
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6. Arm CMSIS csolution extension

The Arm CMSIS csolution extension provides support for working with CMSIS solutions (csolution
projects). The extension manages the information needed to create your csolution projects.

With the CMSIS csolution extension, you can carry out the following tasks:

e Set a context for your csolution

e Use the Solution outline

e Install CMSIS-Packs

e Manage software components

You can also:

e Create a csolution project from scratch

e Convert a Keil wVision project to a csolution project
e Configure a build task

e Initialize your csolution project

e Use the CMSIS csolution AP

For information on working with existing example projects from keil.arm.com instead
of creating new projects from scratch, see Get started with an example project.

6.1 CMSIS solutions

A solution is a container used to organize related projects that are part of a larger application and
that can be built separately. See Project Setup for Related Projects for a solution example.

Solutions are defined in YAML format using *.csolution.yml files. A *.csolution.yml file defines
the complete scope of an application and the build order of the projects that the application
contains. Individual projects are defined using *.cproject.yml files. A *.cproject.yml file defines
the content of an independent build. Each project corresponds to one binary file (build artifact).

You can edit the *.csolution.yml and *.cproject.yml files of a solution manually. The Keil
Studio Pack includes the Red Hat YAML extension and the CMSIS csolution extension uses
YAML schemas to make the editing of these files easier. See the vscode-yaml repository for more
information on the extension.

See the Build Overview of the CMSIS-Toolbox documentation and the Project Examples to
understand how solutions and projects are structured. For more information on csolution project
files, see CMSIS Solution Project File Format.
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6.2 Set a context for your csolution

Look at your csolution contexts. A context is the combination of a target type and build type for a
particular project in your solution.

Procedure
1.

3
Click CMSIS g in the Activity Bar to open the CMSIS view.

2. Choose one of the following options:

Click in the Solution outline header
¢ Select CMSIS: Select a Context for the Solution from the Command Palette

*  Click & in the status bar.

The CMSIS Solution Active Context view opens.

3. Look at the available contexts for the csolution. You can change the target type, the projects
included in the build, and the build type. You can also change the run configuration and the
debug configuration, or add new configurations.

¢ Solution: The name of the active csolution.

o Target: Select a Target Type to specify the hardware to use to build the solution. Some
examples are also compatible with Arm® Virtual Hardware (AVH) targets, in which case
more options are available. For more details on AVH, read the overview.

Click Edit targets in the csolution.yml to specify your target types by editing the YAML file
directly.

e Projects: The project or projects included in the build. If you have multiple projects in your
solution, you can select the projects to include here.

e Build Type: The build configuration. A build configuration allows you to configure each
target type towards specific testing. You can set different build types for different projects
in your solution. You can create your own build types as required by your application,
but two commonly used examples are Debug for a full debug build of the software for
interactive debugging, or Release for the final code deployment to the systems.

¢ Run Configuration and Debug Configuration: Choose a run configuration and a debug
configuration to use for your solution from the drop-down list. You can also:

> Move your mouse over an entry in the list and click the pen icon to edit an existing
configuration

o Click + Add new to add a new configuration

You can define run configurations and debug configurations by editing the
tasks.json file and the 1aunch.json file directly. Alternatively, you can use
the visual editor to define your run and debug configurations. For more
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information on running and debugging your projects, see Arm Debugger
Extension.

4. Click Edit cproject.yml next to a project in the Projects list to open the <project-
name>.cproject.ynl file. YAML syntax support helps you with editing.

5. Go to the PROBLEMS tab and check for errors.

6. Open the main.c file and check the IntelliSense features available. Read the Visual Studio Code
documentation on IntelliSense to find out about the different features.

Next steps
A =.cprj file is generated automatically for the selected context each time that you update the
<project-name>.csolution.yml file.
You can optionally turn off the automatic generation of cprj files.
1. Open the settings:
e On Windows or Linux, go to File > Preferences > Settings.
e On macQOSs, go to Code > Settings > Settings.

2. Find the Cmsis-csolution: Auto Generate Cprj setting and clear its checkbox.

6.3 Use the Solution outline

The Solution outline presents the content of your solution in a tree view.

Jt
Click CMSIS C in the Activity Bar to open the CMSIS view. The Solution outline displays on the

left.

The Solution outline shows the cprojects included in the solution. Each cproject file contains
configuration settings, source code files, build settings, and other project-specific information.
The extension uses these settings and files to manage and build a software project for a board or
device.

You can have the following details for a cproject:
e Groups: Groups are a way to structure code files into logical blocks.

e components: All the software components selected for the cproject. Components are sorted by
component class (Cclass). Code files, user code templates, and APIs from selected components
display under their parent components. Click the files, templates, or APIs to open them in the
editor.

e Layers: I'he clayer file, *.clayer.yml, defines the software layers for the cproject. A software
layer is a set of source files, preconfigured software components, and configuration files. The
clayer file can be used by multiple projects. The software components used by each layer in the
cproject appear in the tree view.
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The Solution outline label displays the name of your active solution. When you move your cursor
over the label, you can choose one of the following actions:

Build: Click to build all the cprojects included in the active solution. You can also build
each cproject individually. The Solution outline displays the selected build type next to each
cproject.

Run: Click to run the csolution on your hardware. Select a run task in the drop-down list
that displays at the top of the window.

The Run option is also available for each individual project in the csolution.

Debug: Click m to debug the csolution. Select a debug configuration in the drop-down list that
displays at the top of the window.

The Debug option is also available for each individual project in the csolution.

e Open Csolution File: Open the main csolution.yml file. When you move your cursor over a
project or a layer, an Open File option is also available.

Select a Context for the Solution: Click to set a context for your solution.
Collapse All: Click to close all the entries in the outline.

More Actions !:
o Clean: Clean the output directories for the active solution
o Rebuild: Clean the output directories before building the cprojects

o Convert puVision Project to Csolution: Convert an existing uVision project to a csolution
project

> New CMSIS Solution: Create a csolution project from scratch

o Open CMSIS Solution: Select the active solution. If you have several solutions in your
workspace, this option allows you to switch from one solution to another. The same option
is available from the Explorer when you right-click the csolution.ymil file. Select a solution
in the drop-down list that displays at the top of the window.

A build type and target display next to each cproject. You can check which software components

are selected for each cproject. Click m to open the Software Components view.
Press Ctrl+F (Windows) or Cmd+F (macOS) to look for an element in the Solution outline.
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The *.csolution.yml, *.cproject.yml, and *.clayer.yml file formats are described in the Open-
CMSIS-Pack documentation.

6.4 CMSIS-Packs

CMSIS-Packs offer you a quick and easy way to create, build, and debug embedded software
applications for Cortex®-M devices.

CMSIS-Packs are a delivery mechanism for software components, device parameters, and board
support. A CMSIS-Pack is a file collection that might include:

e Source code, header files, and software libraries - for example, RTOS, DSP, and generic
middleware

e Device parameters, such as the memory layout or debug settings, along with startup code and
Flash programming algorithms

e Board support, such as drivers, board parameters, and descriptions for debug connections
e Documentation and source code templates

e Example projects that show you how to assemble components into complete working systems

CMSIS-Packs are developed by various silicon and software vendors, covering thousands of
different boards and devices. You can also use them to enable life-cycle management of in-house
software components.

See the Open-CMSIS-Pack documentation for more details.

Discover new CMSIS-Packs on keil.arm.com/packs. Snippets that you can copy to add a pack to
yOour csolution.yml file and to install packs with cpackget add are available for each pack.

6.5 Install CMSIS-Packs

If you started from an example available on keil.arm.com, then the CMSIS-Packs you need for the
example are already listed in the csolution.yml file under the packs key. The CMSIS csolution
extension scans your pack cache and offers to install any missing packs. See Install missing CMSIS-
Packs for more details.

If you need to add CMSIS-Packs in your example solution, or if you are creating a solution from
scratch, then you can explore the available CMSIS-Packs on keil.arm.com. See Explore the available
CMSIS-Packs for more details.

See also Support for packs to understand the difference between public and private packs and how
you can manage packs from the command line.
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6.5.1 Install missing CMSIS-Packs

Install the missing CMSIS-Packs for your solution.

Procedure

L Open the *.csolution.yml file for your csolution project from the Explorer view @

The required packs are listed under the packs key of the csolution.yml file. If one or more
CMSIS-Packs are missing, errors display in the PROBLEMS view and a pop-up message
displays in the bottom right-hand corner with the message “Solution [solution-name] requires
some packs that are not installed”.

2. Click Install.
Alternatively, right-click the error in the PROBLEMS view and select Install missing pack. If
there are several packs missing, use Install all missing packs.

You can also install missing packs with the CMSIS: Install required packs for active solution
command from the Command Palette.

6.5.2 Explore the available CMSIS-Packs

Explore the available CMSIS-Packs on keil.arm.com and install them.

Procedure
1. Go to the CMSIS-Packs page on keil.arm.com.
2. Search for a pack and select it in the Results list. For example, type wolfssr.

3. Copy the packs snippet and update the packs key of your csolution.yml file in Visual Studio
Code.

Figure 6-1: wolfSSL example

Add to CMSIS Solution

packs:
- pack: wolfSSL::wolfSS5L@5.6.6 D

Add with cpackget
= cpackget add wolfSSL::wolfSSL@s.6.6 (D

Download
= wolfSSL 5.6.6

4. Install the pack by clicking Install in the pop-up message that displays in the bottom right-hand
corner.
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6.6 Manage software components

The Software Components view shows all the software components selected in the active project
of a CMSIS solution.

From this view you can see all the component details, called attributes in the Open-CMSIS-Pack
documentation.
You can also carry out the following tasks:

e Modify the software components to include in the project, and manage the dependencies
between components for each target type defined in your solution, or for all the target types at
once

e Build the solution using different combinations of pack and component versions, and different
versions of a toolchain

6.6.1 Open the Software Components view

Describes how to open the Software Components view.

Procedure

&

Click CMSIS E# in the Activity Bar to open the CMSIS view.

Move your cursor over the Solution outline, and then click Manage software components H

Results
The Software Components view opens.

The default view displays the components available from the packs listed in your solution
(Software packs: Solution drop-down list and All toggle button).

You can use the Search field to search the list of components.

With the Project drop-down list, select the project for which you want to modify software
components.

With the Target drop-down list, select All Targets or a specific target type to modify software
components for all the target types in your solution at once, or for a specific target only.

With the Software packs drop-down list, you can filter on the components available from the
packs listed in your solution, or display the components from all the packs available in the CMSIS
ecosystem.
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Figure 6-2: The ‘Software Components’ view showing all the components available from the
packs listed in a solution

& Software Components X

Project: kws Target: All Targets Software packs: Solution b Validation

o Selected (21) | All (632) 0 component(s) with issues

Variant Version Vendor Software Pack
You don't have any validation errors in

CMSIS (6) this project.
Cortex Microcontroller Software Interface Components

CORE 5.6.0 Ep CMSIS@5.9.0
CMSIS-CORE for Cortex-M, SC000, SC300, Star-MC1, ARMv8-M, ARMv8.1-M

DSP Source
DSP (1)
NN Lib

RTOS (1)
CMSIS-RTOS API for Cortex-M, SC000, and SC300

¥ Keil RTX5 554 Ep CMSIS@5.9.0
CMSIS-RTOS RTX5 implementation for Cortex-M, SC000, and SC300

B RTOS2 (1)
CMSIS-RTOS API for Cortex-M, SC000, and SC300

CMSIS Driver (16)
Unified Device Drivers compliant to CMSIS-Driver Specifications

CMSIS-View (3)
Debugger visualization of software events and statistics

The CMSIS-Pack specification states that each software component should have the following
attributes:

e Component class (Cclass): A top-level component name (for example, CMSIS)

e Component group (Cgroup): A component group name (for example, CORE for the CMSIS
component class)

e Component version (Cversion): The version number of the software component

Optionally, a software component might have these additional attributes:

e Component subgroup (Csub): A component subgroup that is used when multiple compatible
implementations of a component are available (for example, Keil RTX5 under CMSIS > RTOS2)

e Component variant (Cvariant): A variant of the software component that is typically used when
the same implementation has multiple top-level configurations, like Library for Keil RTX5

e Component vendor (Cvendor): The supplier of the software component (for example, ARM)

e Bundle (Cbundle): Allows you to combine multiple software components into a software
bundle. Bundles have a different set of components available. All the components in a bundle
are compatible with each other but not with the components of another bundle. For example,
ARM Compiler for the Compiler component class.

Layer icons . indicate which components are used in layers. In the current version, layers are
read-only, so you cannot select or clear them from the Software Components view. Click the layer
icon of a component to open the *.clayer.yml file or associated files.
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Documentation links are available for some components at the class, group, or subgroup level. Click
the Learn more link of a component to open the related documentation.

6.6.2 Modify the software components in your project

You can add components from all the packs available, not just the packs that are already selected
for a project.

Procedure

1. In the Project drop-down list, select the project for which you want to modify software
components.

2. In the Target drop-down list, select a specific target type, or, if you want to modify all the target
types at once, select All Targets (note that some examples have only one target).

3. In the Software packs drop-down list, you can filter on the components available from the
packs listed in your solution (Solution option), or display the components from all the packs
available in the CMSIS ecosystem (All packs option).

4. Check that the All toggle button is selected to display all the components available, or switch to
Selected to display only the components that are already selected.

5. Use the checkboxes to select or clear components as required. For some components, you can
also select a vendor, variant, or version.
The cproject.yml file is automatically updated.

6. Manage the dependencies between components and solve validation issues from the
Validation panel.

Issues are highlighted in red and have an exclamation mark icon n next to them. You can
remove conflicting components from your selection or add missing component dependencies
from a suggested list.

7. If there are validation issues, move your cursor over the issues in the Validation panel to get
more details. Click the proposed fixes to find the components in the list. In some cases, you
might have to choose between different fix sets. Select a fix set in the drop-down list, make the
required component choices, and then click Apply.

If a pack is missing in the solution, a “Component’s pack is not included in your solution”
message displays in the Validation panel. An error also displays in the PROBLEMS view. See
Install CMSIS-Packs for information on how to install CMSIS-Packs.

There can be other issues such as:

e A component that you selected is incompatible with the selected hardware and toolchain.

e A component that you selected has dependencies which are incompatible with the selected
hardware and toolchain.

« A component that you selected has unresolvable dependencies. In such cases, you must
remove the component. Click Apply from the Validation panel.
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6.6.3 Undo changes

In the current version, you can undo changes from the Source Control view or by directly editing
the cproject.yml file.

6.7 Create a csolution project
Create a csolution project from scratch.
Procedure

1. To create a solution, either:

4
Click CMSIS g' in the Activity Bar to open the CMSIS view. Then:

o If you are starting from an empty workspace, click Create a New Solution.

o |f you already have a solution opened in your workspace and want to create a new
one in the same workspace, move your cursor over the Solution outline, and then click

More Actions ! > New CMSIS Solution.

e Go to the File menu and select New File..., then select CMSIS Solution in the drop-down
list that opens at the top of the window.

The Create New CMSIS Solution view opens.

2. Click the Target Board drop-down list. Enter a search term, and then select a board.
A picker shows you the details of the board that you selected.
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Target Board Target Device Target Type

Select Board Select Device

&2 Apollo

Apollo1 EVB (Ver
Ambiq Micro (5) 1.0)
Apollod Plus EVB (Ver 1.0)
Apollo3 Blue Plus EVB (Ver 0.1)
Apollo3 Blue EVB (Ver 1.0)
Apolle2 EVB (Ver 1.0)
Apollel EVB (Ver 1.0)

Ambiqg Micro

Cores Cortex-M4
Mounted Devices APOLLOS12-KBR

Memory 1x 512 KiB IROM1
1x 64 KiB IRAM1

3. Click Select.
The Target Device drop-down list and Target Type field are filled in by default with the name of
the device mounted on the board that you selected.

Alternatively, you can directly select a device in the Target Device drop-down list.

4. In the Target Type field, you can customize the name of the target hardware that is used to
deploy the solution. The Target Type displays in the CMSIS Solution Active Context view and
is setin the <solution name>.csolution.yml file (target—types: - type:).

5. Select one of the following options from the Templates and Examples drop-down list:
Note that the option or options available depend on the board or device that you selected.

e Create a blank solution

o Create a TrustZone solution. TrustZone is a hardware-based security feature that provides
a secure execution environment on Arm-based processors. It allows the isolation of secure
and non-secure zones, enabling the secure processing of sensitive data and applications. If
the board or device that you selected is compatible, you can decide if your solution should
use the TrustZone technology and define which project in the solution should use secure or
non-secure zones.

e Use an example project as a starting point
6. For blank and TrustZone solutions only, configure the projects in your solution:

e |f you selected Blank solution: One project is added for each processor in the target
hardware. You can change the project names. You can decide to add secure Or non-secure
zones with the TrustZone drop-down list if the board or device is compatible. By default,
TrustZone is off.
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e |If you selected Trustzone solution: Two projects (a secure project and a non-secure
project) are added for each processor in the target hardware that supports TrustZone. You
can change the project names. You can also change the zones (secure Or non-secure) in the
TrustZone drop-down list, or remove TrustZone by selecting off.

7. Click Add Project to add projects to your solution and configure them. For TrustZone, you can
add as many secure Or non-secure projects as you need for a particular processor.

8. For blank and TrustZone solutions only, select a compiler: Arm Compiler 6, GCC, or LLVM.
9. You can change the name for your solution in the Solution Name field.

10. Click Browse next to the Solution Location field and choose where to store the files of the
solution using the system dialog box that opens.

11. With the Initialize Git repository checkbox, you can initialize the solution as a Git repository.
Clear the checkbox if you do not want to turn your solution into a Git repository.

12. Click Create.
The extension creates the solution. Examples available only in *.uvprojx format are converted
automatically. If there are conversion errors, check the uv2csolution.log file available.

A dialog box displays. You can carry out the following tasks:
e Open the solution in a new workspace (Open option)

e Open the solution in a new window and new workspace (Open project in new window
option)
e Add the solution to the current workspace (Add project to vscode workspace option)

13. Select one of the options.
The extension also generates a vepkg-configuration.json file with the tools that you need to
set up your development environment. An Arm Environment Activation dialog box displays.

14. Confirm that the Environment Manager extension can automatically activate the workspace and
download the tools specified in your vepkg-configuration.json file.

15. Check that the files for the solution have been created:
e A vcpkg-configuration.json file
o« A <solution name>.csolution.yml file
e One or more <project_name>.cproject.yml files, each available in a separate folder

e Amain.c template file for each project

Next steps
Explore the autocomplete feature available to edit the csolution.yml and cproject.yml files. Read
the CMSIS-Toolbox > Build Overview documentation for project examples.

Add CMSIS components with the Software Components view. When you add components, the
cproject.yml files are updated.
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6.8 Convert a Keil uVision project to a csolution project

You can convert any Keil® LVision® project to a csolution project from the CMSIS csolution
extension. Note that the conversion does not work with Arm® Compiler 5 projects. You can
download Arm Compiler 5 projects from the website, but you cannot use them with the
extensions. Only Arm Compiler 6 projects can be converted. As a workaround, you can update
Arm Compiler 5 projects to Arm Compiler 6 in Keil uVision, then convert the projects to csolutions
in Visual Studio Code. For more help and information on converting to Arm Compiler 6, see the
Migrate Arm Compiler 5 to Arm Compiler 6 application note and the Arm Compiler for Embedded
Migration and Compatibility Guide.

Procedure
1. Open the project that contains the *.uvprojx that you want to convert in Visual Studio Code.

2. Right-click the *.uvprojx and select Convert puVision Project to Csolution from the Explorer.
The conversion starts immediately.

o
Alternatively, if you are starting from an empty workspace, you can click CMSIS g in the

Activity Bar to open the CMSIS view. Then choose one of the following two options:

e Click Convert a uVision Project and open your *.uvprojx file to convert it

Move your cursor over the Solution outline, click More Actions ! then select Convert
KVision Project to Csolution and open your *.uvprojx file to convert it

A dialog box displays. You can carry out the following tasks:
e Open the solution in a new workspace (Open option)

e Open the solution in a new window and new workspace (Open project in new window
option)

You can also run the CMSIS: Convert pVision project to Csolution command from the
Command Palette. In that case, select the *.uvprojx that you want to convert on your machine
and click Select.

If there are conversion errors, check the uv2csolution.log file available.

3. Confirm that the Environment Manager extension can automatically activate the workspace and
download the tools specified in your vepkg-configuration.json file.

4. Check the OUTPUT tab (View > Output). Select uVision to Csolution Conversion in the drop-
down list on the right-hand side of the OUTPUT tab.
The *.cproject.yml and *.csolution.yml files are available in the folder where the *.uvprojx
is stored.
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6.9 Configure a build task

In Visual Studio Code, you can automate certain tasks by configuring a file called tasks.json. See
Integrate with External Tools via Tasks for more details.

With the CMSIS csolution extension, you can configure a build task using the tasks.json file to
build your projects. When you run the build task, the extension runs cbuild with the options that
you defined.

As mentioned in Get started with an example project, the examples provided
on keil.arm.com are shipped with a tasks.json file that already contains
some configuration settings to build your project. You can modify the default
configuration if needed.

If you are working with an example for which no build task has been configured yet, follow these
steps:

1. Go to Terminal > Configure Tasks....
2. Inthe drop-down list that opens at the top of the window, select the CMSIS Build task.

A tasks.json file opens with the default configuration.

3. Modify the configuration.

With IntelliSense, you can see the full set of task properties and values available in the
tasks.json file. You can bring up suggestions using Trigger Suggest from the Command
Palette. You can also display the task properties specific to cbuild by typing cbuild --help in
the terminal.

4. Save the tasks.json file.

Alternatively, you can define a default build task using Terminal > Configure Default Build Task....
The Terminal > Run Build Task... option triggers the execution of default build tasks.

6.10 Initialize your csolution project

If you have a csolution project that does not already contain a vepkg-configuration.json file, a
tasks.json file, and a 1aunch.json file, you can use the Initialize CMSIS project option to generate
these files and start working with your project. Examples from keil.arm.com or csolution projects
created from scratch from the Create New CMSIS Solution view already contain the JSON files
required.

Procedure
1. From the Explorer, open your workspace.

2. Right-click anywhere in the workspace and select Initialize CMSIS project.
The extension generates ad vcpkg-configuration.json ﬁle, d tasks.json ﬁ|€, and a launch.json
file that are already preconfigured.
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6.11 Use the CMSIS csolution API

If you want to create your own Visual Studio Code csolution extension, the CMSIS csolution
extension exposes an API that other extensions can use.

For the API specification, see the CMSIS csolution extension APl page.

For information about authoring extensions, see the Extension API chapter in the Visual Studio
Code documentation.

For csolution examples, go to keil.arm.com.
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7. Arm Device Manager extension

Look at the hardware supported with the Keil® Studio extensions.

Then, manage your hardware with the Device Manager extension:
e Connect your hardware
e Edit your hardware

e Open a serial monitor

7.1 Supported hardware

Describes the hardware that the Device Manager extension and other Keil® Studio extensions
support.

7.1.1 Supported development boards and MCUs

The extensions support the development boards and MCUs available on keil.arm.com.

7.1.2 Supported debug probes

The following debug probes are supported.

7.1.2.1 WebUSB-enabled CMSIS-DAP debug probes

The extensions support debug probes that implement the CMSIS-DAP protocol, such as:

e The DAPLink implementation: see the ARMmbed/DAPLink repository
e The LPC-Link2 implementation: see the LPC-Link2 documentation
e The Nu-Link2 implementation: see the Nuvoton repository

e The ULINKplus™ (irmware version 2) implementation: see the Keil MDK documentation

See the CMSIS-DAP documentation for general information.

7.1.2.2 ST-LINK debug probes

The extensions support ST-LINK/V2 probes and later, and the ST-LINK firmware available for these
probes.

The recommended debug implementation versions of the ST-LINK firmware are:
e For ST-LINK/V2 and ST-LINK/V2-1 probes: J36 and later
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e For STLINK-V3 probes: J6 and later

See “Firmware naming rules” in Overview of ST-LINK derivatives for more details on naming
conventions.

7.2 Connect your hardware
Describes how to connect your hardware for the first time.

Procedure
1.

Click Device Manager 58 in the Activity Bar to open the extension.

2. Connect your hardware to your computer over USB.
The hardware is detected and a pop-up message displays in the bottom right-hand corner.

3. Click OK to use the hardware.

Alternatively, click Add Device and select your hardware in

the drop-down list that displays at the top of the window.
Your hardware is now ready to be used to run and debug a project.

Next steps
If you need to add more hardware, click Add Device in the top right-hand corner.

7.3 Edit your hardware

If your board cannot be detected or if you are using an external debug probe, you can edit the
hardware entry from the Device Manager and specify a Device Family Pack (DFP) and a device
name retrieved from the pack to be able to work with your hardware. DFPs handle device support.

Procedure

L Move your cursor over the hardware that you want to edit and click Edit Device .

2. Edit the hardware name in the field that displays at the top of the window if needed and press
Enter. This is the name that displays in the Device Manager.

Select a Device Family Pack (DFP) CMSIS-Pack for your hardware in the drop-down list.
4. Select a device name to use from the CMSIS-Pack in the field and press Enter.

@
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7.4 Open a serial monitor

Open a serial monitor. The serial output shows the output of your board. You can use the serial
output as a debugging tool or to communicate directly with your board.

Procedure

1. Move your cursor over the hardware for which you want to open a serial monitor and click

Open Serial =

A drop-down list displays at the top of the window where you can select a baud rate (the data
rate in bits per second between your computer and your hardware). To view the output of your
hardware correctly, you must select an appropriate baud rate. The baud rate that you select
must be the same as the baud rate of your active project.

2. Select a baud rate.
A TERMINAL tab opens with the baud rate selected.
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8. Arm Debugger extension

Run a project on your hardware with Arm Debugger and start an Arm Debugger debug session
with the Arm Debugger extension.

For a full list of commands with usage instructions and examples for the Arm Debugger engine, see
the Arm Debugger Command Reference guide.

Most examples provided on keil.arm.com are shipped with tasks.json and
launch.json files that already contain some configuration to run and debug your
project. You can modify the default configuration if needed.

8.1 Run your project on your hardware with Arm
Debugger

Find out how to configure a task to run your project on your hardware and what the configuration
options are.

8.1.1 Configure a task

To run a project on your hardware, you must first configure a task. The task transfers the binary
into the appropriate memory locations on the hardware’s flash memory.

Use the arm-debugger.flash: Flash Device task. The CMSIS-Packs used in your project control
the flash download.

Procedure
1. Open the Command Palette. Search for Tasks: Configure Task and then select it.

2. Select the arm-debugger.flash: Flash Device task.

This task adds the following lines in the tasks.json file in the .vscode folder of the project.

"type": "arm-debugger.flash",

"serialNumber": "${command:device-manager.getSerialNumber}",
"program": "${command:arm-debugger.getApplicationFile}",
"cmsisPack": "${command:device-manager.getDevicePack}",
"problemMatcher": [],

"label": "arm-debugger.flash: Flash Device"

}

3. Save the tasks .Jjson file.
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8.1.2 Override or extend the default run configuration options for Arm
Debugger

You can override or extend the default configuration options. See Arm Debugger run configuration
options.

In order to flash a hardware device, the task configuration must know which CMSIS-Pack to
read information from and the device name in the CMSIS-Pack to use. These settings are named
cmsisPack and deviceName, and you can specify them in multiple ways.

If your target hardware is automatically detected, or if the pack and device name have been set for

it, the task configuration can automatically pick this up by using the following code:

[...]

"serialNumber": "S${command:device-manager.getSerialNumber}",
"cmsisPack": "${command:device-manager.getDevicePack}",
"deviceName": "${command:device-manager.getDeviceName}",

locol

Alternatively, you can specify these settings directly as a full path to the CMSIS-Pack file or a folder
on your machine:

[...]

"serialNumber": "${command:device-manager.getSerialNumber}",
"cmsisPack": "/Users/me/mypack.pack",
"deviceName": "STM32H745XIHx",

local

You can also use the short code for the CMSIS-Pack in the format <vendor>: : <pack>@<version>:

[...]

"serialNumber": "${command:device-manager.getSerialNumber}",
"cmsisPack": "Keil::STM32H7xx DFP@3.1.0",
"deviceName": "STM32H745XIHx",

locol

Note that this code triggers an automatic download of the CMSIS-Pack.

8.1.3 Arm Debugger run configuration options

The extension provides the following run configuration options.

Configuration option  Description

"cmsisPack" Path (file or URL) to a DFP (Device Family Pack) CMSIS-Pack for your hardware. Can be used with: device-
manager.getDevicePack - Gets the CMSIS-Pack for the selected device.
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Configuration option  Description

"connectMode" Connection mode. Possible values: auto (debugger decides), haltOnConnect (halts for any reset before
running), underReset (holds external NRST line asserted), preReset (prereset using NRST), running
(connects to running target without altering state). Default: auto.

"debugClockSpeed" |Maximum clock frequency for the debug communication. Actually used frequency depends on used debug
probe. auto uses a target specific default. Requires Arm Debugger for Visual Studio Code v6.0.2 or later.
Possible values: auto, 50MHz, 33MHz, 25MHz, 20MHz, 10MHz, 5MHz, 2MHz, 1MHz, 500kHz, 200kHz, 100kHz,
50kHz, 20kHz, 10kHz, 5kHz. Default: auto.

"debugPortMode" Debug port mode to use the for the debug connection. Requires Arm Debugger for Visual Studio Code v6.0.2 or
later. Possible values: auto, JTAG, SWD. Default: auto.

"deviceName" CMSIS-Pack device name. Can be used with: device-manager.getDeviceName - Gets the device name
from the DFP (Device Family Pack) of the selected device.

"openSerial" Baud rate to open the serial output of a device after flash (requires Arm Device Manager). Possible values:
115200, 57600, 38400, 19200, 9600, 4800, 2400, 1800, 1200, 600.

"pdsc" Path (file or URL) to a PDSC file.

"probe" Name of probe to use for the debug connection. Possible values: ULINKpro, ULINKpro D, ULINK2, CMSIS-
DAP, ULINKplus, ST-Link. Default: CMSTIS-DAP.

"processorName" CMSIS-Pack processor name for multicore devices.

"program" or Path or paths (file or URL) to one or more projects to use in order of loading. Requires Arm Debugger for Visual

"programs" Studio Code v6.0.2 or later. Can be used with: arm-debugger.getApplicationFile: Returns an AXF or
ELF file used for CMSIS run and debug.

"serialNumber" Serial number of the connected USB hardware to use. Can be used with: device-
manager.getSerialNumber - Gets the serial number of the selected device.

"targetAddress" Synonymous with serialNumber.

"vendorName" CMSIS-Pack vendor name.

"workspaceFolder" |Current Arm Debugger workspace folder. Default: "$ {workspaceFolder}".

Other Visual Studio Code options are also available. Use the Trigger Suggestions command (Ctrl
+Space) to see what is available and read the Visual Studio Code documentation on tasks, as well
as the Schema for tasks.json page.

8.1.4 Use the Run and Debug Configuration visual editor for your run
configuration

As an alternative to editing the tasks.json file of your solution to change the run configuration
options, you can use the Run and Debug Configuration visual editor.

Procedure
1. To open the editor, either:

e From the Explorer, right-click the tasks.json file that is stored in the .vscode folder of the
solution and select Open Run and Debug Configuration.

e From the Explorer, right-click the tasks.json file and select Open With..., then select Run
and Debug Configuration in the drop-down list that displays at the top of the window.

e If the tasks.json file is already open in the editor, click Open Run and Debug
Configuration to the Side @ in the top right-hand corner.
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2. You can define several run configurations in the tasks.json file. Click Add to add a new
configuration block in the JSON file, then select the configuration that you want to modify in
the drop-down list next to Add.

3. Modify your run configuration:

Probe Type: In the drop-down list, select a type for the debug probe that you are using or
the debug unit on your board.

o

Default value: cus1s-pap. If the Arm Debugger extension cannot set the probe type
automatically, the default value is cMs1s-Dap.

If you have connected a probe or a board over USB to your computer, the Arm
Debugger extension sets a probe type based on the serial number of the hardware
detected.

Serial Number: In the drop-down list, select the serial number of the debug probe or debug
unit on your board.

o

Default value: auto. With auto, the serial number of the active device in the
Arm Device Manager extension is used by default. The "${command:device-
manager.getSerialNumber}" command is added in the JSON file for "serialNumber".

You can also select the serial number of the active device in the drop-down list, or
directly type a serial number.

Click Open Arm Device Manager to check what your active device is.
CMSIS-Pack: Select the Device Family Pack (DFP) for the target debug probe or board.

o

Default value: auto. With auto, the DFP for the active device in the Arm
Device Manager extension is used by default. The "s{command:device-
manager.getDevicePack}" command is added in the JSON file for cmsispack.

You can also select the DFP for the active device in the drop-down list, or directly
type the name of a DFP in the format <vendor>: : <pack>@<version>. For example:
ARM: :V2M MPS3 SSE_300 BSPE1.4.0.

CMSIS-Pack Device Name: Select the name of the target device (target chip on your probe
or board).

o

Default value: auto. With auto, the device name is deduced from the information
available for the probe or board. The "${command:device-manager.getDeviceName}"
command is added in the JSON file for deviceName.

You can also select the device name in the drop-down list, or directly type the device
name. For example: Mmps3_sse_300. The device name available in the drop-down list is
the one defined in the *.csolution.yml file of your solution.

Processor Name: If you are using a device with multiple cores, select the processor to use.

o

Default value: auto. With auto, the processor name defined in the
* . csolution.yml file of your solution is used by default. The "${command: csis-
csolution.getProcessorName}" command is added in the JSON file for

"processorName".

You can also directly type a processor name. For example: cm4.
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e Connection Mode: Select a connection mode. The connection mode controls the
operations that are run when the debugger connects to the target debug probe or the
board.

o Default value: auto: The debugger decides which connect mode to use based on the
connected hardware. For ST boards, when auto is selected, underreset is used. For
other boards, haltonconnect is used.

° haltonConnect: Stops the CPU of the target debug probe or board for a reset before
the flash download.

° underReset: Asserts the hardware reset during the connection.
° preReset: Iriggers a hardware reset pulse before the connection.

° running: Connects to the CPU without stopping the program execution during the
connection.

e Program Files: Indicate the path to an AXF or ELF file to run on your hardware. You can
add as many files as you need. Arm Debugger uses the files in the order you provide.

o Default value: The ${command:arm-debugger.getApplicationFile} command is added
in the JSON file for "program" when you add a new configuration block. You can use
arm-debugger.getApplicationFile with AXF or ELF files.

o You can also use the Add button to directly point to a file.

o Baud Rate: Select a baud rate to view the serial output of the target debug probe or board
correctly.

4. Save your changes.

8.1.5 Run your project

Run the project on your hardware.

Before you begin

When you have several solutions grouped in a single folder on your machine, Visual Studio Code
does not take into account the tasks.3son and launch.json files that you might have created for
each solution. Instead, Visual Studio Code generates new JSON files at the root of the workspace
in a .vscode folder and ignores the other JSON files.

As a result, you might have issues running or debugging a project.

As a workaround, open one solution first, then add other solutions to your workspace with the File
> Add Folder to Workspace option.

Procedure

1. Check that your hardware is connected to your computer.

2. Open the Command Palette. Search for Tasks: Run Task and then select it.
3. Select arm-debugger.flash: Flash Device in the dl’Op-dOWI’] list.

Alternatively, if you have installed the Keil Studio Pack, go to the CMSIS view and click Run
in the Solution outline header, or next to the project that you want to run.
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4. If you are using a device with multiple cores and you did not specify a "processorName" in the
tasks.json file, and you do not have the CMSIS csolution extension installed, then you must
select the appropriate processor for your project in the Select a processor drop-down list that
displays at the top of the window.

5. Check the TERMINAL tab to verify that the project has run correctly.

If the Arm Debugger engine cannot be found on your machine, an Arm Debugger not found
dialog box displays.

Select one of these options:

e Click Install Arm Debugger to add it to your environment. The vepkg-configuration.json
file is updated. Check that the environment is activated in the status bar .

e Click Configure Path to indicate the path to the Arm Debugger engine in the settings.

8.2 Debug your project with Arm Debugger

Debug a project.

8.2.1 Add configuration

As is the case for running a project, you must first add a launch configuration to debug your
project. Creating a launch configuration file allows you to configure and save debugging setup
details. Visual Studio Code keeps debugging configuration information in a 1aunch.json file.

Procedure

1. Open the 1aunch.json file that is stored in the .vscode folder of your project and add the
following lines inside "configurations"™: [ 1:

{
"name": "Arm Debugger",
"type": "arm-debugger",
"request": "launch",
"serialNumber": "${command:device-manager.getSerialNumber}",
"program": "${command:embedded-debug.getApplicationFile}",
"cmsisPack": "${command:device-manager.getDevicePack}"

}

2. Save the launch.json file.

8.2.2 Override or extend the default debug configuration options for Arm
Debugger

You can override or extend the default configuration options as required. See Arm Debugger debug
configuration options for more details.

See also the details provided for the tasks.json file for cmsisPack and deviceName. In order to debug
a hardware device, the launch configuration must know which CMSIS-Pack to read information
from and the device name in the CMSIS-Pack to use.
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8.2.3 Arm Debugger debug configuration options

The extension provides the following debug configuration options.

Configuration option Description

"cdbEntry" Arm Debugger Configuration Database Entry to select.

"cdbEntryParams" One or more key/value settings specific to the selected cdbEntry. Example: model params: -f
${workspaceFolder}/model config.txt

"cmsisDevice" Concatenation of CMSIS-Pack name, device vendor, device name, and processor name (if multicore).
Deprecated. Use cmsisPack, pdsc, vendorName, deviceName, and processorName instead.

"cmsisPack" Path (file or URL) to a DFP (Device Family Pack) CMSIS-Pack for your hardware. Can be used with: device-
manager.getDevicePack - Gets the CMSIS-Pack for the selected device.

"connectMode" Connection mode. Possible values: auto (debugger decides), haltOnConnect (halts for any reset before
running), underReset (holds external NRST line asserted), preReset (prereset using NRST), running
(connects to running target without altering state). Default: auto.

"debugClockSpeed" Maximum clock frequency for the debug communication. Actually used frequency depends on used debug
probe. auto uses a target specific default. Requires Arm Debugger for Visual Studio Code v6.0.2 or later.
Possible values: auto, 50MHz, 33MHz, 25MHz, 20MHz, 10MHz, 5MHz, 2MHz, 1MHz, 500kHz, 200kHz,
100kHz, 50kHz, 20kHz, 10kHz, 5kHz. Default: auto.

"debugFrom" The symbol the debugger will run to before debugging. Default: "main™".

"debugPortMode" Debug port mode to use the for the debug connection. Requires Arm Debugger for Visual Studio Code v6.0.2
or later. Possible values: auto, JTAG, SWD. Default: auto.

"deviceName" CMSIS-Pack device name. Can be used with: device-manager.getDeviceName - Gets the device name
from the DFP (Device Family Pack) of the selected device.

"pathMapping" A mapping of remote paths to local paths to resolve source files.

"pdsc" Path (file or URL) to a PDSC file.

"probe" Name of probe to use for the debug connection. Possible values: ULINKpro, ULINKpro D, ULINK2,
CMSIS-DAP, ULINKplus, ST-Link. Default: CMSIS-DAP.

"processorName" CMSIS-Pack processor name for multicore devices.

"program" or Path or paths (file or URL) to one or more projects to use in order of loading. Requires Arm Debugger for

"programs" Visual Studio Code v6.0.2 or later. Can be used with: arm-debugger.getApplicationFile: Returns an
AXF or ELF file used for CMSIS run and debug.

"programMode" Mode to program an application to a target. Possible values: auto, flash, ram, mixed. Default: auto.

"resetAfterConnect" |Resets the device after having acquired control of the processor.

"resetMode" Type of reset to use. Possible values: auto (debugger decides), system (use ResetSystem sequence),
hardware (use ResetHardware sequence), processor (use ResetProcessor sequence). Default: auto.

"searchPaths" Array of paths to source locations.

"serialNumber" Serial number of the connected USB hardware to use. Can be used with: device-
manager.getSerialNumber - Gets the serial number of the selected device.

"targetAddress" Synonymous with serialNumber.

"vendorName" CMSIS-Pack vendor name.

"workspaceFolder" Current Arm Debugger workspace folder. Default: "$ {workspaceFolder}".
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8.2.4 Use the Run and Debug Configuration visual editor for your debug

configuration

As an alternative to editing the 1aunch.json file of your solution to change the debug configuration
options, you can use the Run and Debug Configuration visual editor.

Procedure
1. To open the editor, either:

From the Explorer, right-click the 1aunch.json file that is stored in the .vscode folder of the
solution and select Open Run and Debug Configuration.

From the Explorer, right-click the 1aunch.json file and select Open With..., then select Run
and Debug Configuration in the drop-down list that displays at the top of the window.

If the 1aunch.json file is already open in the editor, click Open Run and Debug

Configuration to the Side @ in the top right-hand corner.

2. You can define several debug configurations in the 1aunch.json file. Click Add to add a new
configuration block in the JSON file, then select the configuration that you want to modify in
the drop-down list next to Add.

3. If you are using a Launch configuration, modify your debug configuration as follows:

Probe Type: In the drop-down list, select a type for the debug probe that you are using or
the debug unit on your board.

o Default value: cus1s-pap. If the Arm Debugger extension cannot set the probe type
automatically, the default value is cMs1s-Dap.

o |f you have connected a probe or a board over USB to your computer, the Arm
Debugger extension sets a probe type based on the serial number of the hardware

detected.

Serial Number: In the drop-down list, select the serial number of the debug probe or debug
unit on your board.

o Default value: auto. With auto, the serial number of the active device in the
Arm Device Manager extension is used by default. The "${command:device-
manager.getSerialNumber}" command is added in the JSON file for "serialNumber".

o You can also select the serial number of the active device in the drop-down list, or
directly type a serial number.

Click Open Arm Device Manager to check what your active device is.
CMSIS-Pack: Select the Device Family Pack (DFP) for the target debug probe or board.

o Default value: auto. With auto, the DFP for the active device in the Arm
Device Manager extension is used by default. The "${command:device-
manager.getDevicePack}" command is added in the JSON file for cmsispack.

o You can also select the DFP for the active device in the drop-down list, or directly
type the name of a DFP in the format <vendor>: :<pack>@<version>. For example:
ARM: :V2M MPS3 SSE 300 BSP@1.4.0.

CMSIS-Pack Device Name: Select the name of the target device (target chip on your probe
or board).
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o Default value: auto. With auto, the device name is deduced from the information
available for the probe or board. The "${command:device-manager.getDeviceName}"
command is added in the JSON file for deviceName.

o You can also select the device name in the drop-down list, or directly type the device
name. For example: Mmps3_sse_300. The device name available in the drop-down list is
the one defined in the *.csolution.yml file of your solution.

e Processor Name: If you are using a device with multiple cores, select the processor to use.

o Default value: auto. With auto, the processor name defined in the
* . csolution.yml file of your solution is used by default. The "s{command:cmsis-
csolution.getProcessorName}" command iS added in the _JSON file for

"processorName".
o You can also directly type a processor name. For example: cm4.

e Connection Mode: Select a connection mode. The connection mode controls the
operations that are run when the debugger connects to the target debug probe or the
board.

o Default value: auto: The debugger decides which connect mode to use based on the
connected hardware. For ST boards, when auto is selected, underreset is used. For
other boards, haltonconnect is used.

° haltonConnect: Stops the CPU of the target debug probe or board for a reset before
the flash download.

° underReset: Asserts the hardware reset during the connection.
° preReset: Iriggers a hardware reset pulse before the connection.

° running: Connects to the CPU without stopping the program execution during the
connection.

e Reset Mode: Select a reset mode. The reset mode controls the reset operations performed
by the debugger.

o auto (default): The debugger decides which reset to use based on information from the
CMSIS-Pack.

o system: Uses the ResetSystem sequence from the CMSIS-Pack.
° hardware: Uses the ResetHardware sequence from the CMSIS-Pack.
° processor: Uses the ResetProcessor sequence from the CMSIS-Pack.

e Debug From: Select a function from which the debugger should start. Default value:
main. The debugging session starts and the debugger stops at the main () function of the
program.

e Program Mode: Select a program mode. The program mode defines the type of debugging
to use: flash debugging f1ash, RAM debugging ram, or both mixed. Default value: auto. In
auto mode, the debugger decides.

The main difference between flash and RAM debugging is in the type of memory used for
storing and executing the code during a debugging session:

o Flash debugging: The code is stored and executed from Flash memory. The debugger
internally loads debug information but does not load anything to the target.
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o RAM debugging: The debugger loads the code into RAM after connection to the target
system. The code is first copied from its storage location (like Flash memory) into RAM
before execution.

e Program Files: Indicate the path to an AXF or ELF file to use for debugging. You can add as
many files as you need. Arm Debugger uses the files in the order you provide.

° Default value: The ${command:arm-debugger.getApplicationFile} command is added
in the JSON file for "program" when you add a new configuration block. You can use
arm-debugger.getApplicationFile with AXF or ELF files.

> You can also use the Add button to directly point to a file.

4. To add an attach configuration, an extra step is required. Click Add Configuration... in the
bottom right-hand corner of the JSON file and select arm Debugger: Attach in the drop-down
list. Use an attach configuration if you want to debug a program that is already running.

See Launch versus attach configurations for explanations on the Launch and attach core
debugging modes in Visual Studio Code.

5. If you are using an attach configuration, modify your debug configuration as follows:

o |f the Arm Debugger engine is running on a distant server, indicate the address of the
server in the format ws: //<host>:<port> (websocket).

o If the Arm Debugger engine is running on your machine, use <host>:<port> (socket).
6. Save your changes.

8.2.5 Start an Arm Debugger session

Start a debug session.

Before you begin

When you have several solutions grouped in a single folder on your machine, Visual Studio Code
does not take into account the tasks.3son and launch.json files that you might have created for
each solution. Instead, Visual Studio Code generates new JSON files at the root of the workspace
in a .vscode folder and ignores the other JSON files.

As a result, you might have issues running or debugging a project.

As a workaround, open one solution first, then add other solutions to your workspace with the File
> Add Folder to Workspace option.

Procedure
1. Check that your device is connected to your computer.
2.

To start a debug session, go to the RUN AND DEBUG view and select the arm Debugger

[* Arm Debugger

configuration in the list . Click Start Debugging.
Alternatively, if you have installed the Keil Studio Pack, go to the CMSIS view and click Debug

E in the Solution outline header, or next to the project that you want to debug.

3. If you are using a device with multiple cores and you did not specify a "processorName™ in the
launch.json file, and you do not have the CMSIS csolution extension installed, then you must
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select the appropriate processor for your project in the Select a processor drop-down list that
displays at the top of the window.

The Run and Debug view displays and the debug session starts. The debugger stops at the
“main” function of your project.

4. Check the Debug Console tab to see the debugging output.
If the Arm Debugger engine cannot be found on your machine, an Arm Debugger not found
dialog box displays.
Select one of these options:
e Click Install Arm Debugger to add it to your environment. The vepkg-configuration.json
file is updated. Check that the environment is activated in the status bar .
e Click Configure Path to indicate the path to the Arm Debugger engine in the settings.

8.2.6 Set breakpoints
Breakpoints are useful when you know which part of your code you want to examine. To look at
values of variables, or to check if a block of code is getting executed, you can set one or more

breakpoints to suspend your running code.

See the Visual Studio Code documentation for more details.

With the current version of the Arm Debugger extension, you cannot set
breakpoints in assembly files by default. To be able to set breakpoints in assembly
files, go to the settings and select Allow Breakpoints Everywhere.

8.2.7 Inspect registers

The Registers view displays register contents for the detected processor. Start a debug session as
explained in Start an Arm Debugger session to display the Registers view in the Run and Debug
view.

The Registers view organizes registers into groups. These groups vary according to the processor
type you are using and the system you are debugging. During debugging, register values change as
your code executes.

Here is an example of what you can see in the Registers view for a Cortex-M4 processor:
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v REGISTERS
RY UxU00V00O0OLO

R10 0x00000000

R11 0x00000000

R12 0x00000C ox00000000
SP 0x2000840C

SP_MAIN 0x2002FF78

SP_PROCESS 0x2000840C
LR O0x00004CAD

PC 0x000038CA

xPSR 0x01000000
PRIMASK 0x00000000
BASEPRI 0x00000000

The Registers view can include:

e Processor core registers: In Arm processors, each processor core has a set of general-purpose
registers that are used for temporary data storage and manipulation during program execution.
These registers are used by the processor for various operations, including arithmetic, logical,
and data movement instructions. Additionally, Arm processors may also have other specific
registers, such as Program Counter (PC) and Stack Pointer (SP), which are essential for
managing program flow and maintaining the stack. These registers collectively form the register
file of the processor core, providing a fast and efficient means for the processor to store and
retrieve data during computation.

e System registers: In Arm processors, system registers are special-purpose registers that control
and configure various aspects of a processor’s behavior. These registers are part of the Arm
architecture and play a crucial role in managing system-level functionality. System registers help
control the processor’s operating mode, interrupt handling, and other system-related features.

e Floating-Point Unit (FPU) registers: In Arm processors, the FPU is responsible for handling
floating-point arithmetic operations. The FPU has its own set of registers distinct from the
general-purpose registers. These registers are used to store floating-point numbers and
perform operations like addition, subtraction, multiplication, and division on them.

8.2.7.1 Edit registers

Edit registers during a debug session.

Procedure
1. Start a debug session as explained in Start an Arm Debugger session.
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Click Pause ||| to pause the debug session.
The Registers view displays register values that you can edit.

Move your cursor over the register values and click the pen icon for the value that you
want to update.

4. Enter a value or an expression in the field that opens at the top of the window and press Enter.
If you enter an expression, the result of the expression is written to the registers. For example:
Use ssp+0x20 to add 0x20 to the content of the sp register. See the Arm Debugger Command
Reference guide for more details on expressions.

Modified values are highlighted in the Registers view.

8.2.8 Next steps

Look at the Visual Studio Code documentation to learn more about the debugging features
available in Visual Studio Code.
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9. Activate your license to use Arm tools

You must activate a license to be able to use tools such as Arm® Compiler, Arm Debugger, or Fixed
Virtual Platforms in your toolchain.

If you try to use a licensed tool without a license, a No Arm License status displays in the status
bar and a pop-up message displays in the bottom right-hand corner.

1. Click Manage Arm license in the pop-up.
2. Select one of the following options in the drop-down list at the top of the window:

e Activate Arm Keil MDK Community Edition (non-commercial use): Select this option to
switch to the Keil® MDK Community Edition license. You can use this license only for non-
commercial projects.

o Activate or manage Arm licenses (opens in new window): Select this option to switch to
the Keil MDK Professional Edition license. This option opens an Arm License Management
Utility window where you can provide a product activation code to activate your Keil MDK
Professional Edition license.

9.1 Troubleshooting expired or cache-expired licenses

If you try to use a licensed tool with a license that is expired or cache-expired, a warning displays in
the status bar and a pop-up message displays in the bottom right-hand corner.

Cache-expired licenses happen when your local license could not be renewed,
either because of network issues, lack of space on your device, or issues with your
permissions.

Click Manage Arm license in the pop-up.

2. Depending on your license, one of the following options displays in the drop-down list at the
top of the window:

o |f your license has expired, a Get help for expired license option displays. Select this option
to view information on the steps that you need to take.

e |f your license is cache-expired, a Get help for cache-expired license option displays. Select
this option to view information on the steps that you need to take.
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10. Use CMSIS-Toolbox from the command
line

CMSIS-Toolbox is a set of command-line tools that are integrated into the Keil® Studio extensions.
You can also use them as standalone tools from the command line.

If you used an official example from keil.arm.com and installed the Keil Studio Pack as
recommended, then CMSIS-Toolbox is already available on your machine as explained in Get
started with an example project.

The main tools that CMSIS-Toolbox provides and that you can use with the command line are:

e cpackget: Pack Manager. Used to install and manage CMSIS-Packs in your development
environment.

e cbuild: Build invocation. Used to orchestrate the build process that translates a project to
an executable binary image. cbuild invokes the different tools (csolution, cpackget, and
cbuildgen) and launches the CMake compilation process.

e csolution: Project Manager. Used to create build information for embedded applications that
consist of one or more related projects.

The Build Tools page describes how to use these tools with the command line.

10.1 Add CMSIS-Toolbox to the system PATH

The Environment Manager extension installs CMSIS-Toolbox and adds the tools into the Visual
Studio Code system PATH.

If you install CMSIS-Toolbox without using the Environment Manager extension, add the
installation path to the system PATH, or use the Cmsis-csolution: Cmsis Toolbox Path setting to
add the path.

10.2 Support for packs

CMSIS-Packs (also often referred to as software packs) contain everything that you need to work
with specific microcontroller families or development boards.

You can work with different types of packs:

e Public packs. These are packs that Arm or silicon and software vendors created and that are
publicly available. Public packs are available from the CMSIS-Packs page on keil.arm.com.

o Private packs. These are packs that you have created but not shared yet, or packs that others
shared with you privately. These can be local packs available on your system or remote packs
available on the web.

This section gives you an overview on how to manage the different types of packs.
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The Open-CMSIS-Pack documentation describes the different ways of adding or
removing packs from the command line in detail. See Adding packs and Removing
packs.

10.2.1 Add public packs

You can use the functionality available in the CMSIS csolution extension to install public packs. See
Install CMSIS-Packs for more details.

Alternatively, you can use the cpackget add command from the terminal to install the latest
published version of public packs listed in the package index of a vendor. A package index
file lists all the CMSIS-Packs hosted and maintained by a vendor. See the Open-CMSIS-Pack
documentation for more information on package index files.

Explore the available CMSIS-Packs on keil.arm.com/packs and use the snippets
available to update your csolution.yml file and install packs with cpackget add.

For example, the following command installs the latest public version of a public pack:

cpackget pack add Vendor::PackName

Where:
e vendor: Is the name of the vendor who created the CMSIS-Pack
e PackName: Is the name of the CMSIS-Pack

After running cpackget add, reload Visual Studio Code to update the data that displays in the user
interface.

10.2.2 Add private local packs

To work with a CMSIS-Pack that you created locally, use the cpackget add command from the
terminal and reload Visual Studio Code so that the CMSIS csolution extension knows about the
registered pack. Components from the pack appear in the Software Components view, and the file
validation takes the new pack into account.

For example, the following command registers a local pack using a PDSC (pack description) file:

cpackget add /path/to/Vendor.PackName.pdsc

Where:
e vVendor: Is the name of the vendor who created the CMSIS-Pack
e PackName: Is the name of the CMSIS-Pack
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PDSC files contain information about the content of packs.

After running cpackget add to add packs to the pack root folder, reload Visual Studio Code to
update the data that displays in the user interface.

If you cannot see the components from the pack or packs that you have just added in the Software
Components view, check the Cmsis-csolution: Pack Cache Path setting and the cmMs1s pack root
environment variable.

10.2.3 Add private remote packs

To install a remote pack available on the web, use the cpackget add command and the URL of the
pack.

For example, the following command installs a pack version that can be downloaded from the web:

cpackget add https://vendor.com/example/Vendor.PackName.x.y.z.pack

Where:
e vendor: Is the name of the vendor who created the CMSIS-Pack
e PackName: Is the name of the CMSIS-Pack

e x.y.z: s the specific version of the pack that you want to install

After running cpackget add, reload Visual Studio Code to update the data that displays in the user
interface.

10.2.4 Remove packs
To remove packs from your system, use cpackget rm.
For example, the following command removes a specific pack version:

cpackget rm Vendor.PackName.x.y.z

Where:

e vVendor: Is the name of the vendor who created the CMSIS-Pack

e PackName: Is the name of the CMSIS-Pack

e x.y.z:lsthe specific version of the pack that you want to remove

After running cpackget rm, reload Visual Studio Code to update the data that displays in the user
interface.
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11. Debug your projects in the cloud with
Arm Embedded Debugger

To debug embedded devices from a web browser, you can use the Arm Embedded Debugger.

Arm Keil Studio Cloud integrates the Arm Embedded Debugger. The Arm Embedded Debugger
extension (Identifier: arm.embedded-debug) is also available in Visual Studio Code for the Web.

Read the following sections to run a project on your hardware with Arm Embedded Debugger and
start an Arm Embedded Debugger debug session.

The examples provided on keil.arm.com are shipped with tasks.json and
launch.json files that already contain some configuration to run and debug your
project. You can modify the default configuration if needed.

11.1 Run your project on your hardware with Arm
Embedded Debugger

Find out how to configure a task to run your project on your hardware and what the configuration
options are.

11.1.1 Configure a task

To run a project on your hardware, you must first configure a task. The task transfers the binary
into the appropriate memory locations on the hardware’s flash memory.

There are two tasks available:

¢ Flash Device: Use this task for CMSIS-DAP hardware (for example, LPC-Link2, Nu-Link2, and
ULINKplus™) and ST-Link hardware. The CMSIS-Packs used in your project control the flash
download.

¢ Flash Device (DAPLink): Use this task for DAPLink hardware. The DAPLink firmware takes care
of the flash download.

Procedure

1. Openthe Command Palette. Search for Tasks: configure Task and then select it.

2. Select the embedded-debug. flash:Flash Device task or the embedded-debug.daplink-

flash:Flash Device (DAPLink) task.

Depending on the task that you selected, this action adds the following lines in the tasks.json
file in the .vscode folder of the project.
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Default configuration for Flash Device:

"label": "Flash Device",

"type": "embedded-debug.flash",

"program": "${command:embedded-debug.getApplicationFile}",
"serialNumber": "${command:device-manager.getSerialNumber}",
"cmsisPack": "${command:device-manager.getDevicePack}",
"problemMatcher": [],

"dependsOn": "CMSIS Build"

Default configuration for Flash Device (DAPLink):

{

"type": "embedded-debug.daplink-flash",

"serialNumber": "${command:device-manager.getSerialNumber}",
"program": "${command:embedded-debug.getBinaryFile}",
"problemMatcher": [],

"label": "embedded-debug.daplink-flash: Flash Device (DAPLink)"
}

3. Save the tasks .Jjson file.

11.1.2 Override or extend the default run configuration options for the
Embedded Debugger

You can override or extend the default configuration options. See Embedded Debugger run
configuration options for CMSIS-DAP and ST-Link hardware (Flash Device) and Embedded
Debugger run configuration options for DAPLink hardware (Flash Device DAPLIink).

If you are using a Flash Device task, then in order to flash a hardware, the task configuration must
know which CMSIS-Pack to read information from and the device name in the CMSIS-Pack to use.
These settings are named cmsisPack and deviceName, and you can specify them in multiple ways.

If your target hardware is automatically detected, or if the pack and device name have been set for

it, the task configuration can automatically pick this up by using the following code:

[...]

"serialNumber": "${command:device-manager.getSerialNumber}",
"cmsisPack": "${command:device-manager.getDevicePack}",
"deviceName": "${command:device-manager.getDeviceName}",

locol

Alternatively, you can specify these settings directly as a full path to the CMSIS-Pack file or a folder
on your machine:

[...]
"serialNumber": "${command:device-manager.getSerialNumber}",
"cmsisPack": "/Users/me/mypack.pack",

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 61 of 70



Arm® Keil” Studio Visual Studio Code Extensions User Guide

Document ID: 108029 0000 10 en

Debug your projects in the cloud with Arm Embedded Debugger

"deviceName" :

locol

"STM32H745XIHx",

You can also use the short code for the CMSIS-Pack in the format <vendor>: : <pack>@<version>.
Note that this triggers an automatic download of the CMSIS-Pack:

[...]

"serialNumber": "${command:device-manager.getSerialNumber}",
"cmsisPack": "Keil::STM32H7xx DFP@3.1.0",

"deviceName": "STM32H745XIHx",

[...]

11.1.3 Embedded Debugger run configuration options for CMSIS-DAP and
ST-Link hardware (Flash Device)

The extension provides the following task configuration options.

Configuration option Description

"cmsisPack” Path (file or URL) to a DFP (Device Family Pack) CMSIS-Pack for your hardware. Command available:
device-manager.getDevicePack - Gets the CMSIS-Pack for the selected device.

"connectMode" Connection mode. Possible values: auto (debugger decides), haltOnConnect (halts for any reset before
running), underReset (holds external NRST line asserted), preReset (prereset using NRST), running
(connects to running target without altering state). Default: auto.

"dbgconf" Path (file or URL) to a debug configuration file (dbgconf) file.

"deviceName" CMSIS-Pack device name. Command available: device-manager.getDeviceName - Gets the device
name from the DFP (Device Family Pack) of the selected device.

"eraseMode" Type of flash erase to use. Possible values: sectors (erase only sectors to be programmed), full (erase full

chip), none (skip flash erase). Default: sectors.

"flm" or "flms"

Path or paths (file or URL) to an FLM file or FLM files.

"openSerial" Baud rate for connected device. Opens the serial output of the device in the TERMINAL tab with the baud
rate specified.

"pdsc" Path (file or URL) to a PDSC file.

"processorName" CMSIS-Pack processor name for multicore devices.

"program" Or

Path or paths (file or URL) to one or more projects to use. Command available: embedded-

"programs" debug.getApplicationFile - Returns an AXF or ELF file used for CMSIS run and debug.
"programFlash" Program code into flash. Default: true.
"programMode" Mode to program an application to a target. Default: auto.

"resetAfterConnect"

Resets the hardware after having acquired control of the CPU. Default: true.

"resetMode" Type of reset to use. Possible values: auto (debugger decides), system (use ResetSystem sequence),
hardware (use ResetHardware sequence), processor (use ResetProcessor sequence). Default: auto.

"resetRun" Issue a hardware reset at end of flash download. Default: true.

"sdf" Path (file or URL) to an SDF file.

"serialNumber" Serial number of the connected USB hardware to use. Command available: device-
manager.getSerialNumber - Gets the serial number of the selected device.

"targetAddress" Synonymous with serialNumber.

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 62 of 70




Arm® Keil® Studio Visual Studio Code Extensions User Guide Document ID: 108029_0000_10_en

Debug your projects in the cloud with Arm Embedded Debugger

Configuration option Description

"vendorName"

CMSIS-Pack vendor name.

"verifyFlash"

Verify the contents downloaded to flash. Default: true.

Other Visual Studio Code options are also available. Use the Trigger Suggestions command (Ctrl
+Space) to see what is available and read the Visual Studio Code documentation on tasks, as well
as the Schema for tasks.json page.

11.1.4 Embedded Debugger run configuration options for DAPLink

hardware (Flash Device DAPLink)

The extension provides the following task configuration options.

Configuration Description

option

"openSerial" Baud rate for connected device. Opens the serial output of the device in the TERMINAL tab with the baud rate
specified.

"program" Path or paths (file or URL) to one or more projects to use. Command available: embedded-
debug.getBinaryFile - Returns a BIN or HEX file.

"serialNumber" |Serial number of the connected USB hardware to use. Command available: device-manager.getSerialNumber

- Gets the serial number of the selected device.

Other Visual Studio Code options are also available. Use the Trigger Suggestions command (Ctrl
+Space) to see what is available and read the Visual Studio Code documentation on tasks, as well
as the Schema for tasks.json page.

11.1.5 Run your project

Run the project on your hardware.

Before you begin

When you have several solutions grouped in a single folder on your machine, Visual Studio Code
does not take into account the tasks.3son and 1aunch.json files that you might have created for
each solution. Instead, Visual Studio Code generates new JSON files at the root of the workspace
in a .vscode folder and ignores the other JSON files.

As a result, you might have issues running or debugging a project.

As a workaround, open one solution first, then add other solutions to your workspace with the File
> Add Folder to Workspace option.

Procedure
1. Check that your hardware is connected to your computer.

2. Open the Command Palette. Search for Tasks: Run Task and then select it.
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3. Select the embedded-debug. flash:Flash Device task or the embedded-debug.daplink-
flash:Flash Device (DAPLink) task in the drop-down list.

Alternatively, if you have installed the Keil Studio Pack, go to the CMSIS view and click Run m
in the Solution outline header, or next to the project that you want to run.

4. If you are using a device with multiple cores, you must select the appropriate processor for your
project in the Select a processor drop-down list that displays at the top of the window.

5. Check the TERMINAL tab to verify that the project has run correctly.

11.2 Debug your project with the Embedded Debugger

Debug a project.

11.2.1 Add configuration

As is the case for running a project, you must first add a launch configuration to debug your
project. Creating a launch configuration file allows you to configure and save debugging setup
details. Visual Studio Code keeps debugging configuration information in a 1aunch.json file.

Procedure

1. Open the 1aunch.json file that is stored in the .vscode folder of your project and add the
following lines inside "configurations™: [ 1:

{

"configurations": [
{
"name": "Embedded Debug",
"type": "embedded-debug",
"request": "launch",
"serialNumber": "${command:device-manager.getSerialNumber}",
"program": "${command:embedded-debug.getApplicationFile}",
"cmsisPack": "${command:device-manager.getDevicePack}",
"debugFrom": "main"

}

2. Save the 1aunch.json file.

11.2.2 Override or extend the default debug configuration options for the
Embedded Debugger

You can override or extend the default configuration options as required. See Embedded Debugger
debug configuration options for more details.

See also the details provided for the tasks.json file for cmsispack and deviceName. In order to debug
a hardware device, the launch configuration must know which CMSIS-Pack to read information
from and the device name in the CMSIS-Pack to use.
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11.2.3 Embedded Debugger debug configuration options

The extension provides the following task options.

Configuration option Description

"cmsisPack” Path (file or URL) to a DFP (Device Family Pack) CMSIS-Pack for your hardware. Command available:
device-manager.getDevicePack - Gets the CMSIS-Pack for the selected device.

"connectMode" Connection mode. Possible values: auto (debugger decides), haltOnConnect (halts for any reset before
running), underReset (holds external NRST line asserted), preReset (prereset using NRST), running
(connects to running target without altering state). Default: auto.

"dbgconf" Path (file or URL) to a debug configuration file (dbgconf) file.

"debugFrom" The symbol that the debugger will run to before debugging. Default: "main™.

"deviceName" CMSIS-Pack device name. Command available: device-manager.getDeviceName - Gets the device
name from the DFP (Device Family Pack) of the selected device.

"pathMapping" A mapping of remote paths to local paths to resolve source files.

"pdsc" Path (file or URL) to a PDSC file.

"processorName" CMSIS-Pack processor name for multicore devices.

"program" or

Path or paths (file or URL) to one or more projects to use. Commands available: embedded-

"programs" debug.getBinaryFile: Returns a BIN or HEX file. embedded-debug.getApplicationFile: Returns
an AXF or ELF file used for CMSIS run and debug.
"programNames" Filename or filenames of the projects to be used. Used only for labelling.

"resetAfterConnect"

Resets the hardware after having acquired control of the CPU. Default: true.

"resetMode" Type of reset to use. Possible values: auto (debugger decides), system (use ResetSystem sequence),
hardware (use ResetHardware sequence), processor (use ResetProcessor sequence). Default: auto.

"sdf" Path (file or URL) to an SDF file.

"serialNumber" Serial number of the connected USB hardware to use. Command available: device-

manager.getSerialNumber - Gets the serial number of the selected device.

"svd" or "svdPath"

Path (file or URL) to an SVD file.

"targetAddress" Synonymous with serialNumber.
"vendorName" CMSIS-Pack vendor name.
"verifyApplication™ |Verify application against target memory for each application load operation in debug session. Default: true.

Other Visual Studio Code options are also available. Use the Trigger Suggestions command (Ctrl
+Space) to see what is available and read the Visual Studio Code documentation on tasks.

11.2.4 Start an Embedded Debugger session

Start a debug session.

Before you begin

When you have several solutions grouped in a single folder on your machine, Visual Studio Code
does not take into account the tasks.3son and launch.json files that you might have created for
each solution. Instead, Visual Studio Code generates new JSON files at the root of the workspace
ina .vscode folder and ignores the other JSON files.

As a result, you might have issues running or debugging a project.

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 65 of 70



https://code.visualstudio.com/docs/editor/tasks

Arm® Keil” Studio Visual Studio Code Extensions User Guide Document ID: 108029_0000_10_en

Debug your projects in the cloud with Arm Embedded Debugger

As a workaround, open one solution first, then add other solutions to your workspace with the File
> Add Folder to Workspace option.

Procedure

1. Check that your device is connected to your computer.

:
To start a debug session, go to the RUN AND DEBUG view K<l and select the Embedded

Debug configuration in the list , then click Start Debugging.

Alternatively, if you have installed the Keil Studio Pack, go to the CMSIS view and click Debug

E in the Solution outline header, or next to the project that you want to debug.

3. If you are using a device with multiple cores, you must select the appropriate processor for your
project in the Select a processor drop-down list that displays at the top of the window.
The Run and Debug view displays and the debug session starts. The debugger stops at the
“main” function of your project.

4. Check the Debug Console tab to see the debugging output.

11.2.5 Next steps

Look at the Visual Studio Code documentation to learn more about the debugging features
available in Visual Studio Code.
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12. Known issues and troubleshooting

Describes known issues with the Keil® Studio extensions and how to troubleshoot some common
issues.

12.1 Known issues
Here are the known issues.

Arm CMSIS csolution extension
The CMSIS csolution extension has the following known issues:

e No support for cdefaults.yml. The Software Components view and validation do not use the
compiler set in the cdefaults file.

Arm Embedded Debugger
The Embedded Debugger extension has the following known issues:

e Support for the DWARF debugging standard is limited to version 4. Please make sure that your
application is built with the appropriate settings.

e Variables and registers are read-only.

e Stack trace is limited if the debugger is halted in assembler source files.

12.2 Troubleshooting

Provides solutions to some common issues you might experience when you use the extensions.

12.2.1 Build fails to find toolchain

With the CMSIS csolution extension, errors such as 1d: unknown option: --cpu=Cortex-M4 appear
in the build output. In this example, CMSIS-Toolbox is trying to use the system linker rather than
Arm® Compiler’s armlink.

Solution

1. If you have installed the CMSIS csolution extension separately rather than by using the Keil
Studio Pack, make sure that you follow the instructions for installing and setting up CMSIS-
Toolbox. In particular, make sure that the custs _compILER ROOT environment variable is set
correctly. Alternatively, you can install the Keil Studio Pack to benefit from an automated setup
with Microsoft vcpkg.

2. Clean the solution. In particular, delete the out and tmp directories.
3. Run the build again.
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12.2.2 Connected development board or debug probe not found

You have connected your development board or debug probe, but the Device Manager extension
cannot detect the hardware.

Solution

Run Device Manager (Windows), System Information (Mac), or a Linux system utility tool like
hardinfo (Linux), and then check for warnings beside your hardware. Warnings can indicate that
hardware drivers are not installed. If necessary, obtain and install the appropriate drivers for
your hardware.

On Windows: ST development boards and probes require extra drivers. You can download
them from the ST site.

On Windows: Check if you have an Mbed™ serial port driver installed on your machine. The
Mbed serial port driver is required with Windows 7 only. Serial ports work out of the box

with Windows 8.1 or newer. The Mbed serial port driver breaks native Windows functionality
for updating drivers as it claims all the boards with a DAPLink firmware by default. Arm
recommends that you uninstall the driver if you do not need it. Alternatively, you can disable it.

You can either:

o Uninstall the Mbed serial port driver (recommended): Open a command prompt as an
administrator. Find and delete the mbedserial x64.inf and mbedcomposite x64.inf drivers.

pnputil /enum-drivers

pnputil /delete-driver {oemnumber.inf} /force

Then, connect your hardware using a USB cable and open the Windows Device Manager.
INn Ports (COM & LPT) and Universal Serial Bus controllers, find the mbed entries and
uninstall both by right-clicking them. Finally, disconnect and reconnect your hardware.

o Disable the Mbed serial port driver: Open the Windows Device Manager. In ports (CoM &
LeT), find the Mbed Serial Port. Right-click it and select Properties. Select the Driver tab
and click Update Driver. Click Browse my computer for drivers and then click Let me pick
from a list of available drivers on my computer. Select uss serial Device instead of mped
Serial Port.

On Linux: udev rules grant permission to access USB boards and devices. You must install udev
rules to be able to build a project and run it on your hardware or debug a project.

Clone the pyOCD repository, then copy the rules files which are available in the udev folder to
/etc/udev/rules.d/ as explained in the README.md file. Follow the instructions in the REaDME
file.

After installing the udev rules, your connected hardware is detectable in the Device Manager
extension. You might still encounter a permission issue when accessing the serial output. If this
is the case, run sudo adduser "SUSER" dialout, and then restart your machine.

Check that the firmware version of your board or debug probe is supported and update the
firmware to the latest version. See Out-of-date firmware for more details.
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e Your board or device might be claimed by other processes or tools (for example, if you are
trying to access a board or device with several instances of Visual Studio Code, or with Visual
Studio Code and another IDE).

o Activate the Manage All Devices setting. This setting allows you to select any USB hardware
connected to your computer. By default, the Device Manager extension gives you access only
to hardware from known vendors.

1. Open the settings:
o On Windows or Linux, go to: File > Preferences > Settings.
o On macOs, go to: Code > Settings > Settings.

2. Find the Device-manager: Manage All Devices setting and select its checkbox.

12.2.3 Out-of-date firmware

You have connected your development board or debug probe and a pop-up message appears
mentioning that the firmware is out of date.

Solution
Update the firmware of the board or debug probe to the latest version:

e DAPLink. If you cannot find your board or probe on daplink.io, then check the website of the
manufacturer for your hardware.

e ST-LINK.

e For other WebUSB-enabled CMSIS-DAP firmware updates, please contact your board or debug
probe vendor.

If you are using an FRDM-KL25Z7 board and the standard DAPLink firmware update
procedure does not work, follow this procedure (requires Windows 7 or Windows
XP).

For more information on firmware updates, see also the Debug Probe Firmware Update
Information Application Note.
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13. Submit feedback

If you have suggestions or if you have discovered an issue with any of the Keil® Studio extensions,
please report them to us. Go to the keil.arm.com support page and use the links provided in the
Keil Studio for VS Code category.

Copyright © 2023-2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 70 of 70


https://www.keil.arm.com/support/

	Arm® Keil® Studio Visual Studio Code Extensions User Guide
	Contents
	1. Introduction
	1.1 Conventions
	1.2 Other information

	2. Extension pack and extensions
	2.1 Arm Keil Studio Pack

	3. Intended use cases for the extensions
	4. Get started with an example project
	4.1 Import a csolution example
	4.2 Download and convert a Keil μVision example
	4.3 Finalize the setup of your development environment
	4.3.1 Configure an HTTP proxy (optional)
	4.3.2 clangd (alternative)

	4.4 Build the example project
	4.5 Choose a context for your csolution
	4.6 Look at the Solution outline
	4.7 Install CMSIS-Packs and select software components from packs
	4.8 Connect your board
	4.9 Run the csolution on your board
	4.10 Start a debug session

	5. Arm Environment Manager extension
	5.1 Tools installation with Microsoft vcpkg
	5.2 Check the tools installed with Microsoft vcpkg
	5.3 Modify the manifest file
	5.4 vcpkg activation options
	5.5 Use vcpkg from the command line
	5.6 Confirm automatic activation
	5.7 Use the Environment Configuration visual editor

	6. Arm CMSIS csolution extension
	6.1 CMSIS solutions
	6.2 Set a context for your csolution
	6.3 Use the Solution outline
	6.4 CMSIS-Packs
	6.5 Install CMSIS-Packs
	6.5.1 Install missing CMSIS-Packs
	6.5.2 Explore the available CMSIS-Packs

	6.6 Manage software components
	6.6.1 Open the Software Components view
	6.6.2 Modify the software components in your project
	6.6.3 Undo changes

	6.7 Create a csolution project
	6.8 Convert a Keil μVision project to a csolution project
	6.9 Configure a build task
	6.10 Initialize your csolution project
	6.11 Use the CMSIS csolution API

	7. Arm Device Manager extension
	7.1 Supported hardware
	7.1.1 Supported development boards and MCUs
	7.1.2 Supported debug probes
	7.1.2.1 WebUSB-enabled CMSIS-DAP debug probes
	7.1.2.2 ST-LINK debug probes


	7.2 Connect your hardware
	7.3 Edit your hardware
	7.4 Open a serial monitor

	8. Arm Debugger extension
	8.1 Run your project on your hardware with Arm Debugger
	8.1.1 Configure a task
	8.1.2 Override or extend the default run configuration options for Arm Debugger
	8.1.3 Arm Debugger run configuration options
	8.1.4 Use the Run and Debug Configuration visual editor for your run configuration
	8.1.5 Run your project

	8.2 Debug your project with Arm Debugger
	8.2.1 Add configuration
	8.2.2 Override or extend the default debug configuration options for Arm Debugger
	8.2.3 Arm Debugger debug configuration options
	8.2.4 Use the Run and Debug Configuration visual editor for your debug configuration
	8.2.5 Start an Arm Debugger session
	8.2.6 Set breakpoints
	8.2.7 Inspect registers
	8.2.7.1 Edit registers

	8.2.8 Next steps


	9. Activate your license to use Arm tools
	9.1 Troubleshooting expired or cache-expired licenses

	10. Use CMSIS-Toolbox from the command line
	10.1 Add CMSIS-Toolbox to the system PATH
	10.2 Support for packs
	10.2.1 Add public packs
	10.2.2 Add private local packs
	10.2.3 Add private remote packs
	10.2.4 Remove packs


	11. Debug your projects in the cloud with Arm Embedded Debugger
	11.1 Run your project on your hardware with Arm Embedded Debugger
	11.1.1 Configure a task
	11.1.2 Override or extend the default run configuration options for the Embedded Debugger
	11.1.3 Embedded Debugger run configuration options for CMSIS-DAP and ST-Link hardware (Flash Device)
	11.1.4 Embedded Debugger run configuration options for DAPLink hardware (Flash Device DAPLink)
	11.1.5 Run your project

	11.2 Debug your project with the Embedded Debugger
	11.2.1 Add configuration
	11.2.2 Override or extend the default debug configuration options for the Embedded Debugger
	11.2.3 Embedded Debugger debug configuration options
	11.2.4 Start an Embedded Debugger session
	11.2.5 Next steps


	12. Known issues and troubleshooting
	12.1 Known issues
	12.2 Troubleshooting
	12.2.1 Build fails to find toolchain
	12.2.2 Connected development board or debug probe not found
	12.2.3 Out-of-date firmware


	13. Submit feedback

